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Trademarks

© 2001 Imation Corp.

Imation and Matchprint are trademarks of Imation Corporation.

XEROX®, The Document Company® and the stylized X are trademarks of Xerox
Corporation. Xerox product names profiled within this guide are trademarks of Xerox
Corporation.

Imation Matchprint Co-Branded Xerox Color Laser Proofing Papers are also referred
to as Co-Branded Matchprint Color Laser Proofing Papers and Co-Branded Matchprint
Color Laser Proofs.

Spectrocam is a trademark of Spectrostar BV.

Apple, AppleTalk, AppleShare, and Macintosh are trademarks of Apple computer, Inc.

Ethernet is a trademark of Xerox Corporation.

QuarkXPress is a trademark of Quark, Inc.

Adobe Illustrator, Adobe Photoshop, Adobe PageMaker, Adobe InDesign, Adobe
Separator, PostScript, and PrePrint are trademarks of Adobe Systems Incorporated.

Windows and Windows NT are registered trademarks of Microsoft Corporation.

PANTONE™ Computer Video simulations used in this product may not match
PANTONE-identified solid color standards. Use current PANTONE Color Reference
Manuals for accurate color. "PANTONE Color Computer Graphics" ©Pantone, Inc.
1986, 1993. PANTONE and Pantone Matching System are trademarks of Pantone,
Inc. Pantone, Inc. claims ownership of any copyright in the PANTONE Color
Computer Graphics and Software which are licensed to Imation Corp. to distribute for
use only in combination with the Imation Matchprint™ Professional Server. The
Imation Matchprint™ Professional Server, including the PANTONE Color Computer
Graphics and Software therein, shall not be decompiled, disassembled, modified,
copied onto another diskette or copied into memory unless as part of the execution
of the Imation Matchprint™ Professional Server software. The only permitted used of
the Imation Matchprint™ Professional Server software and any intellectual property
right therein shall be for making proofs/prints as intended by Imation.

SWOP is a certification mark of SWOP, Inc.

Scitex Corporation Ltd.

Stuffit is a trademark of Aladdin Systems, Inc.

All other trademarks are property of their respective owners.
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Product Safety and Compliance

Warning!

Do not modify or use any AC power cord other than the one included with
shipping.

In some cases, the supplied power cord may not be compatible with the AC
wall outlet in your region. If this is true, you must obtain a suitable power cord
that meets the following criteria:

The cord must be rated for use at the AC voltage available, with a current
rating that is at least 125% of the current rating of the product.

The AC plug end must be terminated in a grounding-type male plug designed
for use in your region. The plug ends must be labeled or marked to indicate
they have been certified by an agency acceptable in your region.

The connector at the product end must be an IEC 320, sheet C13, female
connector (or the equivalent EN 60 320 connector.)

The cord must be less than 14.8 feet (4.5 meters) long and, for use in Europe,
be created with <HAR> (harmonized) or VDE certified cordage.

Warning!

1. The user must never remove chassis covers. Some system circuitry retains
voltage even when the system is turned off. Only qualified service technicians
should remove chassis covers.

2. There are no user-serviceable components in the Imation server. Refer all
system repair to a qualified service technician.

Warning! The power supply voltage standby circuit is active when the
computer is turned off. Ensure that the computer is disconnected from its
power source and from all telecommunication links, networks, or modem lines
whenever the chassis cover is removed. Do not operate the computer with the
cover removed. Only qualified service technicians should remove chassis
covers if repair or component replacement is required.

Warning! Danger of explosion if the battery is incorrectly replaced.  Replace
only with the same or equivalent type recommended by the equipment
manufacturer.  Discard used batteries according to manufacturer's
instructions.
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Service Information

Contact your Xerox representative for technical support or product related questions.

Agency Approvals

U.S. FCC Class A required, FCC Class B preferred
UL 1950 standard testing

Canada Canadian EMI Class A
CSA 950

Europe CISPR 22 Class B
CE Mark
EN 60950 LUD

The radiated and conducted emissions are per EN 55022 class B limits.
The radiated and conducted immunity are per EN 55024 class B limits.

For European safety, EN60950 under 73/23/EEC, Low Voltage Directive (LVD)
amendment is correct.
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1 Introduction

1.1 System Overview

The Imation Matchprint™ Professional Server allows client Macintosh™,
Windows® 95/98, Windows NT®, and Windows® 2000 workstations to print files to
the Imation Matchprint™ Professional Server. The Imation Matchprint™
Professional Server accepts the spooled files, processes them, and prints them on
a Xerox® DocuColor 12™ or DocuColor 12™ LP.

Using the Imation Matchprint™ Professional Server, in combination with Imation
Matchprint™ Co-Branded Xerox® Color Laser Proofing Paper, you can produce proofs
that simulate Imation Matchprint™ contract proofs - the most recognized and trusted
standard for color proofing worldwide.

Note: Accurate Imation Matchprint™ Professional Server color is only possible
when using Imation Matchprint™ Co-Branded Xerox® Color Laser Proofing
Paper.

Imation Matchprint™ Professional Server Functions

• Controls the print cycle.

• Recombines Pantone™ and other custom colors into CMYK for best possible
reproduction of these colors.

• Supports color separations to show trapping and overprint.
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• Performs color correction and adjustment.

• Proofs PostScript™, TIFF, TIFF/IT, Scitex™ CT, Photoshop™, CMYK, RGB, PDF,
EPS and DCS2 files. (DSC2 files are processed in single-file format only.)

• Accepts files over the network for printing.

• Accepts files over the network through user definable spoolers and hot folders.

• Responds to requests for proofing.

• Displays job status information.

• Allows setting of job parameters and changes to job ordering.

Imation Matchprint™ Co-Branded Xerox® Color Laser Proofing Paper

Co-developed by Imation and Xerox Supplies, the Imation Matchprint™ Co-Branded
Xerox® Color Laser Proofing Paper is the only paper authorized by Imation and
Xerox to accurately simulate Imation Matchprint™ color.
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1.2 Features Overview

Imation Matchprint™ Professional Server provides the following key features:

• Imation Matchprint simulation

• Imation Color Locking technology

• Imation Color Fidelity Module technology

• Adobe PostScript™ Interpreter (PostScript Level 2, and 3 Support)

• Adobe PDF Support

Enhanced Productivity

• PostScript™ 3 supports 3-dimensional images, smooth gradients (at device's
output resolution), masked image handling, device independent color,
selectable RIP separations, 136 embedded Roman fonts, faster, more efficient
drivers, and full PostScript 3 performance for legacy PostScript 2 files.

• PDF Support. Proof multi-page documents that can be read by any computer
using Adobe™ Acrobat Reader™ software. Ideal format for remote printing
because PDF files are small, compact and versatile (virtually any file can be
converted to PDF.)

• RIP on the Fly. Save time and increase productivity by spooling, RIP'ing and
printing files simultaneously.

• Smart Rotation. Rotate rasterized Scitex™ CT, TIFF, TIFF-IT, and Adobe
Photoshop™ files automatically when printing.

• Print Preview. Optionally view a thumbnail-preview or full-preview of the
printed image before printing. Saves time, paper, and ink when making
changes or experimenting with different settings.

Expanded Color Capability

• ICC Support. Color-correct your prints using a variety of pre-supplied ICC
Device Links and ICC Profiles, or use your own.

• RGB Printing. Print RGB files directly - to preview how RGB images will
reproduce in the printing process. RGB printing saves time since conversion to
CMYK is automatic.

• More Color Separations. Print up to 16 color separations (CMYK plus 12); a
unique ability among printing systems.

• Custom Colors. Create your own custom color libraries tailored to your
specific needs.

• Professional Colors. Imation supplies two Pantone™ color libraries and an
Imation Matchprint™ color library to provide a solid base with a wide range of
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color choices.

• More device links and profiles for color-correcting media. (Device links are
the color space models you use to create your print.)

• Embedded Imation Color Fidelity Module (CFM) allows you to use ICC
profiles in lieu of supplied device links to give you the best possible color
match.

• Black Channel Integrity allows the black components of a CMYK job (black
text, drop shadows, etc.) to print using only the black channel of the DC12.
This improves the appearance of small text and sharpens detail in black-only
images.

Expanded Workflow Capability

• Reusable RIP Files. Save RIP'ed pages with or without proofing them. Proof
this file at a later time or at another location, without having to RIP it again.

• Reusable Spool Files. Save spooled files on disk for later re-proofing or for
remote proofing, so there is no need to repeat the spooling process.

• User-Selectable Parameters. Change storage settings for saved files. For
example, where to save the files, how many days to keep them, and the
maximum total disk space used to save the files.

• Hot Folders and Spoolers. Custom definable hot folders and spoolers for
added workflow flexibility.

Contour and Shading Enhancements

• Anti-Aliasing. Smooth jagged edges on text and line art.

• Sharpening/Softening. Enhance or modify sharpness on the proof.
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2 Getting Started

2.1 Quick Start for Client Printing

To quickly get your system set up for printing from the client, go through the
following procedures listed in the order shown:

1. Start the Imation Matchprint Professional Server software.

2. Printer Setup.

3. Printer Calibration.

4. Add a Spooler.

5. Add a Hot Folder.

6. Set Preferences.

7. Install PPDs.

8. You should now be able to successfully print from your client application to
the DocuColor 12.

2.2 Starting the Software

1. Double-click the Imation Matchprint™ Professional Server software icon.

2. The Imation Matchprint™ Professional Server main application window
appears.
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2.3 Printer Setup

The software is shipped to you with the Printer Settings already set. However, you
should confirm that the Media Settings (media type and size) for each tray match
what is in your DocuColor 12.

Note: If the printer is deleted, you will need to perform the following printer
setup instructions.

To add a printer or change printer settings, complete the following steps:

1. If you have had previous versions of the Imation Matchprint Professional
Server on your system, delete previous printers prior to adding new. If the
system asks you if you want to delete previous files used only with this printer,
select Yes.

2. From the Printer menu, select Add Printer or select XeroxDocuColor 12 (or
the name of the printer you need to change). The Printer Settings window
displays:

3. Confirm the desired Media Settings for each tray and click OK.
The contents of each tray can vary from site to site, however standard tray
setup is as follows:

Contents of: Tray 1 Media Type: Normal Bond Media Size: Letter (8.5 x
11 inches)
Contents of: Tray 2 Media Type: Normal Bond Media Size: LetterRotated
(11 x 8.5 inches)
Contents of: Tray 3 Media Type: Normal Bond Media Size: Legal (8.5 x
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14 inches)
Contents of: Tray 4 Media Type: Normal Bond Media Size: Tabloid (11 x
17 inches) or Heavyweight (12 x 18 inches)
Contents of: Tray 6 (High Capacity Feeder) - Optional Media Type:
Normal Bond Media Size: Letter (8.5 x 11 inches)

Notes:

Tray 5 is a manual feed tray located on the left side of the Xerox DocuColor 12.
(Tray 5 is not configured here.)

Load paper so the watermark wording is face down in the tray.

If calibration is required, go to Printer Calibration.
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2.4 Printer Calibration

For Color critical customers, Imation recommends daily calibration and recalibration
each time the printer is serviced.

Printer calibration can be performed internally by using the DocuColor 12™ built-in
scanner or by using the Spectrostar™ Spectrocam™, an external measurement
device, on the DocuColor 12™ LP. Both procedures are described in this section. If
calibration is to be performed using the Spectrocam, please go through the following
Spectrocam™ Setup instructions before beginning the calibration process.

If calibration is to be performed using the DocuColor 12 scanner, please skip to the
section titled, Calibration Procedure.

Spectrocam™ Setup

1. Shut down the computer.

2. Connect the Spectrocam™ to the COM 1 (or appropriate) serial port on the
back of the Imation Matchprint™ Professional Server.

3. Plug the Spectrocam power connector into the AC adapter and then plug the
AC adapter into a power outlet.

4. Power on the computer.

5. Launch the Imation Matchprint™ Professional Server software.

Note: Always disconnect the Spectrocam™ from the AC power supply before
removing the Spectrocam™ from the Imation Matchprint Professional Server.

Calibration Procedure

1. From the Printer menu, select XeroxDocuColor 12 (or the name of the
printer requiring calibration). The Printer Settings window displays.
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2. Click on Calibration to display menu selections Perform Printer
Calibration and Printer Calibration Setup.

3. Select Printer Calibration Setup to display the following setup screen:

4. Enter how often the printer requires calibration.

The Last Calibration column displays the time elapsed since a particular media
has been calibrated. Uncalibrated medias display "n/a" in this column. If the time
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elapsed is longer than the calibration interval, the “Calibrated?” column will say
No.

Notes:

• Selecting the Reset button, nullifies the most recent calibration and
returns the selected media to its default setting.

• The “Calibrate this printer every___ days” is specific to the printer only.
The “Last Calibration” number indicates when the printer was last
calibrated with specified media. For example, if the printer is set to be
calibrated every 3 days, it may have been 6 days since it was last
calibrated with commercial paper and 2 days since it was last calibrated
with bond. However, regardless of the media type, the printer is set to
be calibrated every 3 days.

5. Click OK.

6. From the Calibration menu, select Perform Printer Calibration. The
following screen appears:

Note: All jobs in the queue are put on hold during calibration except the
jobs currently printing.

7. From the Device drop-down list box, choose either the DocuColor 12
Scanner or the Spectrocam Device.

8. From the Media Type drop-down list box, select the media to be calibrated.
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Note: Transparency media cannot be calibrated.

9. From the Media Size drop-down list box, select the media size on which to
print the calibration form.

10. From the Tray drop-down list box, select the input tray containing the
specified media.

The input tray can be specified if the user wants to calibrate the media
contained in a specific tray of the DocuColor 12. An Automatic selection
chooses the input tray if no input tray is specified. If ExtraHeavyweight or an
Imation/Xerox co-branded media is selected, the input tray defaults to
Manual Feed. In this case, the user is not able to change the input tray.

11. Click on Print Test Form button. A progress bar appears as the form prints:

12. When the form printing is complete:

• Go to Calibrating with the DocuColor12 Scanner for scanner
calibration.

• Go to Calibrating with the Spectrocam for Spectrocam calibration.
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Calibrating with the DocuColor12 Scanner

1. Place the calibration form on the platen of the DocuColor 12 and click
Calibrate.

2. If the calibration is successful, the screen display says, "The calibration
process was successful. You may now calibrate another media."

3. Click OK to go back to the calibration window.

Note:  If the calibration process fails, check to make sure the test page is
properly positioned on the platen. The scanable area is 11"x 17". If the
calibration test form is outside this area, calibration will fail.

Calibrating with the Spectrocam™

1. Place the test form and ruler on the black scanner plate and position the
measurement device on the first patch on the upper, left corner.

2. Click on the Calibrate button.

If the Spectrocam was not previously calibrated, a prompt directs you to
calibrate the white reference. Place the measurement device on the white
target reference and touch the green sensor to calibrate. After calibrating with
the white reference, reposition the measurement device on the first patch on
the upper, left corner of the test form.

3. Touch the green sensor and move the device slowly down the first row. When
you complete the first row, reposition the Spectrocam over the first patch of
the second row and touch the green sensor again to begin measuring the
second row. Continue in this fashion until all rows are read.

Important Note on Calibrating the Spectrocam™: Every Spectrocam™
needs to be calibrated against its own unique White Reference Target (an
absolute white point) before taking measurements. Take good care of your
Reference Target. For additional information, please see the Spectrocam™
user documentation.
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• Patches are read from left to right in a slow, steady manner. The color
patches appear on the screen as they are measured. It should take
approximately 6 to 8 seconds to completely scan one row.

• If you move too slowly or too rapidly, patches are not read correctly.
Within the calibrate dialog an X appears on any patch that is miss-read. If
this happens, reposition the device on the first patch of that row and
touch the sensor to start the patch reading of that row again. The
Instruction box at the top of the window will indicate any action you must
take regarding measurement readings.

To read the last two rows, you will need to move the test form up so the
Spectrocam rests on the black scanner plate.

Note:  The system times out after 10 minutes of inactivity. Instructions
appear directing the user to restart calibration.

If the calibration is successful, the following message appears: "The calibration
process was successful. You may now calibrate another media."

 

4. Click on OK to return to the calibration window.
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Spectrocam TIPs and Troubleshooting

Calibrating the Spectrocam

• Make sure the Spectrocam is calibrated with the white target reference that was
shipped with your Spectrocam. The serial numbers on the bottom of the white
target reference target and the Spectrocam must match. Setting the white
reference to a different target can result in inaccurate printed color.

• When measuring the white target reference, be sure the device is seated
correctly.

Scanning the Test Form

• Make sure the printed test form is properly aligned to the black scan plate. The
Spectrocam must read the first patch directly in the center. If a white edge is
detected, calibration will fail.

• Make sure the Spectrocam is securely seated in the guide ruler and not tipped
while you read patches. Tipping or miss-aligning the Spectrocam while on the
guide ruler will cause errors.

• The green sensor on the top of the Spectrocam responds to transitions from light
to dark. The sensor must be activated to measure each row. Inadvertently
covering the sensor can prematurely initiate the measurement sequence.

• Listen for the flashlamp before you move off the first patch. Sometimes there is a
slight delay before it begins to measure.

• Reading patches too rapidly is a common error. Scanning one row should take
about 6 to 8 seconds.
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2.5 Adding a Spooler

Creating a spooler allows workstations to see the proofer over the network as a
custom printer with its own user definable configurations. Files that are sent to the
spooler are automatically entered into the Job Queue for proofing.

Note for Windows® NT and 2000: At the client Windows machine, either log
into the same domain as the Imation Matchprint™ Professional Server, or
connect to the Imation Matchprint™ Server with a valid user name and
password that has a minimum of read access. For security purposes, Imation
does NOT recommend enabling the Guest Account.

Failure to do so will result in Windows 2000 clients receiving the following error
message when trying to print an image: "Could not complete the print command
because the selected printer driver could not be found. Please select a printer
from the control panel and try again."

1. From the Input menu, select Add Spooler. The Spooler Settings window
displays. Spooler option tabs are Printer, Color, Output, PDF, Preview and
Summary.

2. Enter the Printer Name to which the new Spooler will send jobs. This name
is what client users will see when they select a printer on the net.

Note: When creating a spooler to be used in a mixed Operating System
environment, remember that Windows 95/98 require the spooler name to
be 12 characters or less. (Alpha-numeric characters and spaces are
allowed.

3. Make sure Active is checked. (The default setting is for Active to be
checked.)

4. Click on Printer, Color, Output, PDF, Preview and Summary tabs to enter the
Spooler configuration. When the file enters this Spooler, it is given these
default settings.

Note: For PostScript jobs submitted via a Print File, job parameter settings for
Number of Copies, Input Tray and Media Type override the PostScript file codes.
For all other settings, the PostScript file settings override the job parameter
settings.

For jobs submitted through a spooler or hot folder, the values in the Postscript file
always override the default job parameters for that spooler or hot folder.

To view tab information, go to Setting Job Parameters.
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Spooler Options
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2.6 Adding a Hot Folder

Hot Folders are folders the Imation Matchprint™ Professional Server software
"watches" for incoming job files. When a recognized file is placed into a Hot Folder, it
is automatically entered into the job queue for printing.

Important! Files are automatically deleted from a Hot Folder after
successfully printing. Do not place original files into Hot Folders. Always "copy"
files to a Hot Folder.

1. From the Input menu, select Add Hot Folder. The Hot Folder Settings
window displays. Hot Folder option tabs are Printer, Color, Output, PDF,
Preview and Summary.

2. Select the location of the Hot Folder by clicking Browse... You may select an
existing folder or create a new folder. (Create a new folder by navigating to
the location where you want the folder. At the end of the path string type
\xxx [where xxx is the new folder name], then click OK. Answer Yes to the
question, "Do you want the folder to be created?")

3. Make sure Active is checked. (The default setting is for Active to be
checked.)

4. Enter the Poll Interval seconds to set how often this Hot Folder will be
checked for jobs.

5. Click on Printer, Color, Output, PDF and Summary tabs to enter Hot Folder
custom configurations. When the file enters this Hot Folder, it is given these
default settings.

Note: For PostScript jobs submitted via a Print File, job parameter settings for
Number of Copies, Input Tray and Media Type override the PostScript file codes.
For all other settings, the PostScript file settings override the job parameter
settings.

For PostScript jobs submitted through a spooler or hot folder, the values in the
PostScript file always override the default job parameters for that spooler or hot
folder.

To view tab information, go to Setting Job Parameters.
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Hot Folder Options
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2.7 Setting Preferences

Select Preferences from the File menu. The File Preferences dialog box displays.

The Preferences dialog contains three tabs: General, Cache, and Paths.

2.7.1 General Tab

The General tab allows you to customize how sizes are displayed in the File
Information and Job Parameters subsets, and to customize the Job Slug Options.

Display Units allows you to set inches, centimeters, or pixels. This setting
customizes how sizes are displayed in the File Information and Job Parameter
subsets.

Language allows you to select English, French, Italian, German, or Spanish
languages. You need to restart the software for a language change to take affect.

Job Slug Options allows you to selectively display document name, user name,
media type, color target, date and time, printer name and job ID. The Job Slug is an
optional block of information that can be added to your proofs. (See Setting Job
Parameters.)
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2.7.2 Cache Tab

The Cache tab allows you to customize how spooled or RIP'd job files are
saved. Files can be purged based on age, total size, or both.

• Select Keep Spooled Job Files to retain spooled jobs, which can then be
reused so you don't have to re-send the job over the network. De-selecting
Keep Spooled Job Files does not purge pre-existing job files.

• Enter the number of days and/or megabytes the Spooled Job files should
be saved. (The default is 14 days or when 2000 MB is exceeded.) When the
size limit is exceeded, the fewest possible files (oldest first) are deleted.

• Enter the number of days and/or megabytes the RIP'ed Job files should
be saved. (The default is 14 days or when 2000 MB is exceeded.) When the
size limit is exceeded, the fewest possible files (oldest first) are deleted.
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2.7.3 Paths Tab

The Paths tab allows you to customize the location of where the server will save
RIP'ed, spooled and temporary files. The folder setting for each of the file categories
is listed.

Saved Jobs: Location of saved spooled jobs. See the "Keep Spooled Job
Files" setting in the Cache tab.

Temporary Files: Temporary working space the RIP uses during processing.
RIP processing requires up to 1.5 gigabytes of available disk space.

RIP'ed Pages: Location of saved RIP'ed pages. See the "Save RIP'ed Pages"
setting in the Output tab of Setting Job Preferences.

To change a folder setting, select the appropriate Browse... button of the folder you
wish to change. A Choose Folder dialog box is displayed. Select the desired folder.
The Preferences dialog box is updated to reflect your selection.

Note: Changes to the Saved Jobs, Temp Files, or RIP'ed Pages folder take
effect immediately, although jobs currently processing will not be affected. (Note
that Postscript™ temp files are not stored in the Temp Files folder.)
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2.8 Quitting the Software

Select Exit from the File menu to leave the Imation Matchprint™ Professional
Server software application.

Note: The application places any active jobs on hold when Exit is selected.

2.9 Deleting a Printer

Microsoft Windows® Systems

Delete a printer from a Microsoft Windows® client as follows:

1. From the Printer menu, select the printer to be deleted. Then right-click and
select Delete.

2. Select Start -> Settings-> Control Panel -> Printers.

3. Select the printer you want to delete, then right-click and select Delete.

Note: The spooler name can be visible for up to 2 hours after the spooler has
been deleted. This is a known issue with Microsoft Windows®. Users can confirm
a spooler exists by navigating to the server and viewing it over the network.

Macintosh® Systems

To delete a printer (spooler) from a Macintosh® desktop, just drag and drop into the
Trash.
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2.10  Setting Job Parameters

Job Parameters are set for each Spooler or Hot Folder.

Note: Job Parameter dialog boxes can be viewed from Print File, Hot Folder,
Spoolers, and Edit/View Parameters.

1. Select a job (highlight) in the job queue and click to view job parameters, OR
select a job in the job queue, then select Edit Parameters from the Queue
menu, OR select File > Print File and pick a file to print. The Job Parameter
screen appears with the following tabs: Printer, Color, Output, PDF, Preview,
and Summary.

2. Go through each tabbed section and select the desired Job Parameters.

2.10.1 Printer Tab

Printer identifies the Xerox DocuColor 12 as the printer.

Resolution lists 600 x 600 DPI for the printer.

Input Tray is used to select the input media tray. See Xerox DocuColor 12



Imation Matchprint™ Professional Server User Guide

Imation Corp. 2001 31

User's Guide for more information on paper weight, sizes and proper paper
tray selection.

Media Type is used to view and select Media Type.

Media Size is used to view and select Media Size.

Require Calibration is checked if the user needs to be notified when the
printer requires calibration. If a printer requires calibration, jobs are put on
hold and a message to the user appears stating, "Printer is out of calibration:
please calibrate the printer to continue." Jobs are released after the printer is
calibrated.

Note: For PostScript jobs submitted via a Print File, job parameter settings
for Number of Copies, Input Tray and Media Type override the PostScript
file codes. For all other settings, the PostScript file settings override the job
parameter settings.

For jobs submitted through a spooler or hot folder, the values in the
PostScript file always override the default job parameters for that spooler or
hot folder.

2.10.2 Color Tab

Mode: Select Basic or Advanced. Basic mode is the default. When the
user selects a Color Target Adjustment file in either Basic or Advanced
mode, the color transformation is performed using the associated device
link/profile or by allowing the users to select their own custom ICC color
profiles. Advanced mode allows the user more color control of the final
proof.

Basic Mode Controls
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RGB Color Space is used to select an RGB Source profile if a Color Space
Array (CSA) is not present in the PostScript stream. The four RGB source
profiles provided are: Adobe™ RGB 1998, Apple™ RGB, ColorMatch™ RGB,
sRGB.

RGB Link is used to select the RGB device link used on incoming RGB Raster
files.

CMYK Link is used to select the CMYK device link used on incoming CMYK
files.

Note: Color Target Adjustment (CTA) files appear in the CMYK Link menu when
the CTA was created to adjust a link.

Gray Adjust is used to select an optional grayscale adjustment. See
Grayscale Target Adjustment for more information. Select a grayscale
adjustment file to modify grayscale color processing.

Print a small "proof mark" when Imation-approved color settings are
used. When this box is checked, a proof mark will appear on Co-Branded
Matchprint™ Color Laser Proofing Paper and color targets.

Supplied ICC Device Links - Basic Mode

The device link drop-down list allows the user to select a pre-built ICC device
link profile that maps the CMYK output of the RIP to the output device.

The following list contains the supplied ICC Device Links available in Basic
mode:

Japanese Press Color - A CMYK ICC device link, targeted to DIC
color. This color target is intended for use on Xerox Color Xpressions
bond paper.

Short Run Color - A CMYK ICC device link, targeted to Imation
Matchprint Classic SWOP color. This color target is intended for use on
Xerox Color Xpressions bond paper.

Newsprint Color - A CMYK ICC device link, targeted to newsprint
color. This color target is intended for use on Xerox Color Xpressions
bond paper.

Internet Graphics - An RGB or CMYK ICC device link, targeted to
sRGB color space. This color target is intended for use on Xerox Color
Xpressions bond paper. Internal code ensures the device link (RGB or
CMYK) maps to your selected media.

Business Graphics - An RGB or CMYK ICC device link, targeted to
saturated or vivid color. This color target is intended for use on Xerox
Color Xpressions bond paper or Transparency. Internal code ensures
the device link (RGB or CMYK) maps to your selected media.

Uncorrected - No color correction, output runs to 400% total ink, this
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option will not be an available selection when setting up a spooler or
hot folder. A warning will be displayed if user selects this target at the
server. This target should only be used to create an ICC profile of the
device.

Matchprint US Web Standard - A CMYK ICC device link, targeted to
Imation Matchprint™ Classic SWOP® colors. This color target is
intended for use on the glossy, heavier weight Co-Branded
Matchprint™ Color Laser Proofing Commercial and Publication Paper.

Matchprint US Web Low Gain - A CMYK ICC device link, targeted to
Imation Matchprint™ SWOP® Lo-Gain colors. This color target is
intended for use on the glossy, heavier weight Co-Branded
Matchprint™ Color Laser Proofing Commercial and Publication Paper.

US Web SWOP® - A CMYK ICC device link, targeted to a certified
SWOP® press sheet. This color target is intended for use on the
glossy, heavier weight Co-Branded Matchprint™ Color Laser Proofing
Publication Paper.

Matchprint US Sheetfed - A CMYK ICC device link, targeted to
Imation Matchprint™ Commercial Lo-Gain colors. This color target is
intended for use on the glossy, heavier weight Co-Branded
Matchprint™ SuperWhite or Commercial paper. Internal code ensures
the device link maps to your selected media.

Matchprint Euro Low Gain - A CMYK ICC device link, targeted to
Imation Matchprint™ Euro Commercial Lo-Gain with Opaque Cyan
colors. This color target is intended for use on the glossy, heavier
weight Co-Branded Matchprint™ SuperWhite or Commercial paper.

Matchprint Euro Med Gain - A CMYK ICC device link, targeted to
Imation Matchprint™ Euro Standard colors with Opaque Cyan colors.
This color target is intended for use on the glossy, heavier weight Co-
Branded Matchprint™ SuperWhite or Commercial paper.
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Advanced Mode Controls - With Office Color

Advanced Mode Controls with Office Color selected, does not allow for CMYK source
simulation.

Advanced Mode Controls - Without Office Color

Advanced Mode without Office Color selected allows the user to simulate other
CMYK sources.

RGB Color Space is used to select an RGB Source profile if a Color
Space Array (CSA) is not present in the PostScript stream. The four RGB
source profiles provided are: Adobe™ RGB 1998, Apple™ RGB,
ColorMatch™ RGB, sRGB.

RGB Source must be selected if you are printing an RGB file that is not
in PostScript format. The RGB source must match the client application's
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work space where the image was created, otherwise results will be
unpredictable.

CMYK Source is available if Office Color is unchecked. Use this drop-
down list to select the source to be simulated.

Destination is used to select the profile of the output device.

Note: Color Target Adjustment (CTA) files appear in the Destination menu
when the CTA was created to adjust a Destination profile.

Rendering Intent is used to allow for different methods of mapping
the source space to the destination space. Perceptual is
recommended when using the Imation Matchprint™ Professional
Server.

Note: In the Matchprint™ Professional Server, the Saturation intent maps
identically to the Relative Colorimetric rendering intent. These settings
would normally be used for producing high-color business graphics.
Absolute Colorimetric intent is most useful when printing a media that
has a very different white point, such as simulating newsprint.

Office Color applies to RGB files only. If checked, RGB files will proof
using the RGB Source Profile and the Destination Device Profile. If
unchecked, RGB files will proof using the RGB Source Profile, the CMYK
Source Profile, and the Destination Device Profile. Checking and Un-
checking this box causes the content of the "arrows" picture to
change, depicting the sequence of profile usage.

Note: The Office Color check box allows the user to map directly from the
RGB source profile to the output device. The resultant image utilizes the
entire gamut of the output device. These images should appear to have
more color.

When the Office Color check box is selected, an arrow points from the
source profile to the destination profile giving the user an indication of the
transform to be performed by the RIP. When the Office Color check box is
not selected, the arrow points from the RGB Source to the Target CMYK
profile and then to the device CMYK profile.
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Supplied ICC Profiles - Advanced Mode

The CMYK profiles represent a characterization of the output of the printing device.
To make a proof, the CMYK target space is mapped into the CMYK space of the
printer. The CMYK device profiles are made for each base material to be supported
by the RIP.

The following list contains the supplied ICC Profiles available in Advanced mode.

Source Profliles:
Adobe (1998) - ICC profile
Apple RGB - ICC profile
Colormatch RGB - ICC profile
sRGB - ICC profile
Matchprint US Web Standard - Imation™ format profile of
Matchprint™ Classic SWOP® colors.
Matchprint US Web Low Gain - Imation™ format profile of
Matchprint™ Lo-Gain SWOP® colors.
US Web SWOP® - Imation™ format profile of a certified SWOP®
press sheet.
Matchprint US Web S - Imation™ format profile of Matchprint™
SWOP Lo-gain colors on Publication base.
Matchprint US Sheetfed - Imation™ format profile of Matchprint™
Lo-Gain Commercial colors.
Matchprint Euro Low Gain - Imation™ format profile of
Matchprint™ Euro Commercial Lo-Gain (Opaque Cyan) colors.
Matchprint Euro Medium Gain - Imation™ format profile of
Matchprint™ Euro Standard (Opaque Cyan) colors.
Japanese Press Color - Imation™ format profile, targeted to DIC
color.
Short Run Color - Imation™ format profile, targeted to Imation
Matchprint™ Classic SWOP® color.
Newsprint Color - Imation™ format profile, targeted to newsprint
color.

Destination Profiles:
DC12 Commercial - ICC profile of a Xerox™ DC12 color copier on
Co-Branded Matchprint™ Color Laser Commercial Paper.
DC12 Publication - ICC profile of a Xerox™ DC12 color copier on
Co-Branded Matchprint™ Color Laser Publication paper.
DC12 SuperWhite - ICC profile of a Xerox™ DC12 color copier on
Co-Branded Matchprint™ Color Laser SuperWhite paper.
DC12 Normal Bond - ICC profile of a Xerox™ DC12 color copier on
a Xerox 20 to 32 lb. Normal Bond paper.
DC12 Heavyweight Bond - ICC profile of a Xerox™ DC12 color
copier on a Xerox 32 to 90 lb. Heavyweight Bond paper.
DC12 Extra Heavyweight Bond - ICC profile of a Xerox™ DC12
color copier on a Xerox 65 to 140 lb. Extra Heavyweight Bond paper.
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2.10.3 Output Tab

Rotation controls printed page orientation. Possible settings are
Never, Always, and Smart. (Smart rotation causes the file to be
rotated to fit the selected paper.) Availability depends on type of
image; not available for PS or PDF files.

CMYK/Gray Control Scale  is used to add a control scale to the job.
A control scale is a small image placed toward the bottom of the
printed page which contains patches of known colors. The user can
look at these patches to see if the color came out correctly, and use
that information to judge the overall quality of the print. (Imation and
Gretag Control Scales are provided.)

Anti-Aliasing settings are Off, Good, and Best. Only enabled for text-
based files - PS or PDF.

Sharpness settings are Low, Medium and High. Low = no sharpening.
Medium = Moderate sharpening. High = High degree of sharpening.
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Duplexing. Select Off, Top/Bottom, or Left/Right to enable duplexing
feature. Top/Bottom refers to pages that are viewed as first the top
page, then flipped up to view the back side of the page. Left/Right
refers to traditional book bound pages that are flipped from left to
right.

Output Tray. Select output tray or mailbox.

Note: Mailbox locations are only visible if "mailbox" is enabled on the Xerox
DocuColor 12 sorter. Contact your Xerox technician to enable this setting.

Reduce/Enlarge has a range of 25% to 600%, with a default of
100%. The edit field is disabled if To Fit is checked.

To Fit resizes the image to fit the selected orientation/rotation on the
given page size. If Rotate is Smart, the orientation will be set to give
the largest image. Not available for PostScript files. Availability
depends on RIP type.

Copies sets the number of copies. Input string is limited to 3 digits.

Note: For PostScript jobs submitted via a Print File, job parameter settings
for Number of Copies, Input Tray and Media Type override the PostScript
file codes. For all other settings, the PostScript file settings override the job
parameter settings.

For jobs submitted through a spooler or hot folder, the values in the
PostScript file always override the default job parameters for that spooler or
hot folder.

Pages allows you to select All pages or a range of pages to print.
Input string is limited to 4 digits. Default selection is All.

Print Job Slug. If checked, job slug items are printed on the bottom
of the proof. Job slug items are document name, user name, media
type, color target, date and time, printer name and job ID. The job
slug items are shown if they are selected in the Preference dialog. See
Setting Preferences.

Save RIP'ed Pages. If checked, the application saves the RIP'ed file
before sending it to the printer. Allows you to print again without re-
RIPing. These files are saved in the RIP'ed Pages folder. See the
Paths tab under Setting Preferences for the folder location of Saved
RIP'ed pages.

Note: RIP'ed files are color calibrated files. Saved RIP'ed files will print
using the original color management settings defined by the user when the
file was first RIP'ed.

Collate Output. When Collate Output is checked, pages are output in
the order 1, 2, 3, 1, 2, 3... and so on. When the Collate Output is not
checked, pages are output 1, 1, 2, 2, 3, 3... and so on.

Reverse Print Order. If checked, reverses the print order of the job.
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(If Collate Output is checked, Reverse Print Order is automatically set
as well.)

RIP Only/No Proof. If checked, the application RIPs the job and
sends it to an intermediate file, but doesn't print it.

Staple Output. Not currently available.

2.10.4 PDF Tab

PDF Password contains the password for password protected PDF files.

2.10.5 Preview Tab

File Information group displays basic file information: width, height, and
source DPI.

Create and Hold for Preview. When checked, the system creates an image
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preview and places job on "Preview Hold" before printing. To view the
preview, edit or view the job parameters and go to the Preview tab. Note:
The image preview will not appear until after the job has RIP'ed. If you look
at the preview before RIP'ing has finished, you will see the normal page
layout view.

Full Preview button displays a full screen dialog of the preview if a preview
has been created, otherwise this button is not enabled.
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2.10.6 Summary Tab

The Summary tab contains most configured settings. Clicking on an
underlined item takes you to the appropriate tab to change that item.
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2.11  Paper Size and Image Area

The following table contains all paper sizes supported by the Imation Matchprint™
Professional Server.

Notes:

• All paper sizes up to 11" x 17" have a 12 point (0.167 inches) border for the
imageable area.

• 12" x 18" paper has a 12 point border for the long edge (LE) and 28 point
border for the short edge (SE) for the imageable area.

• LEF = Long Edge Feed; SEF = Short Edge Feed

• Expanded measurements refer to the Expanded Image Area feature.

Paper Type Border  Paper Size

A3 12 point (0.167") 11.69" x 16.54"

SRA3 Normal = 24 point (0.33") for LE
              17 point (0.236”) for SE

Expanded = 24 point (0.33”) for LE
                   9 point (0.125”) for SE

12.6" x 17.7"

A4* (SEF or LEF) 12 point (0.167") 8.27" x 11.69"

A5 (SEF or LEF) 12 point (0.167") 5.83" x 8.27"

A6 12 point (0.167") 5.83" x 4.13"

B4 12 point (0.167") 10.12" x 14.33"

B5 (SEF or LEF) 12 point (0.167") 7.17" x 10.12"

B6 (SEF or LEF) 12 point (0.167") 4.92” x 6.92”

8" x 10" 12 point (0.167") 8" x 10”

Legal 12 point (0.167") 8.5" x 14"

Legal 13 12 point (0.167") 8.5" x 13"

Letter* (SEF or LEF) 12 point (0.167") 8.5" x 11"

Tabloid 12 point (0.167") 11" x 17"

12” x 18” Normal = 12 point (0.167”) for LE
               28 point (0.389”) for SE

Expanded = 8 point (0.111”) for LE
                   9 point (0.125”) for SE

12" x 18"

Statement 12 point (0.167") 5.5" x 8.5"

* Input tray 6 of the DocuColor 12 is a High Capacity Feeder (HCF) for A4 and 8.5" x
11" letter paper.
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2.12  Enabling Expanded Printer Image Area

The Expanded Printer Image Area capability is a feature of the Xerox DocuColor 12.
This feature requires Xerox IOT software version 11.50.3h or higher, an updated

Imation Postscript Printer Driver (PPD) and associated Imation Matchprint™
Professional Server files.

Checking DocuColor 12 Software Version

Using the DocuColor 12 front panel, click on the tool icon button to bring up the
access menu on the screen display.

1. Select the Meters button.

2. The Xerox IOT software version is located in the lower, left area of the screen.

Notes:

If you do not have the correct software version and are interested in obtaining
this feature, contact your Xerox sales representative for additional information.

If you have the correct software version and associated Imation files, complete
the following steps to enable this feature.

Enabling Expanded Printer Image Area on the Xerox DocuColor 12

1. Using the DocuColor 12 front panel, click on the tool icon button to bring up the
Tools menu on the display screen.

2. Select the Tools button

3. Enter your Access Number.

4. Select Enter.

5. Choose the Machine Set-up button.

6. Choose the down-page arrow to get to page 2 of 2.

7. Highlight Printer Image Area.

8. Select Change Settings.

9. Select Expanded.

10. Choose Save, Close, then Close again to exit.
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Enabling Expanded Printer Image Area on the Imation Matchprint™
Professional Server

1. Quit the Imation Matchprint™ Professional Server software.

2. Navigate to …\Imation\Imation Matchprint Professional Server\Print
Area Setups\Expanded Area.

3. Double-click on the file Expanded_Area_Setup.exe and follow the installation
instructions.

Enabling Expanded Printer Image Area from a Client

Windows Clients:

A. Windows® 95/98

1. Make sure the Expanded Printer Image Area is enabled on the Xerox DocuColor
12 and in the Imation Matchprint™ Professional Server software.

2. Delete all current Imation Matchprint™ Professional Server printers from the
client.

3. Re-add the desired Imation Matchprint™ Professional Server printers.

B. Windows NT®

All Imation Matchprint™ Professional Servers accessed from a Windows NT client
should automatically update the PPD each time the client uses the Imation
Matchprint® Professional Server. Therefore, no manual intervention should be
necessary.

If problems arise when using an Imation Matchprint™ Professional Server printer
with the Expanded Printer Image Area feature, follow the instructions for Windows®
95/98 client.

Macintosh® Clients:

1. Make sure the Expanded Printer Image Area is enabled on the Xerox DocuColor
12 and in the Imation Matchprint™ Professional Server software.

2. Refer to the Macintosh® Client PPD section for instructions on installing the
Imation PD to be used with the Expanded Printer Image Area feature.
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2.13  Save/Restore Configuration

The Save and Restore RIP Configuration is a simple backup procedure designed to
protect your RIP configuration setup in the event that software needs to be reloaded.

This procedure saves and selectively restores the following information:

• Input Methods

• Printer Definitions

• Preferences

• Color Target Adjustments

• User Color Libraries

2.13.1 Save Configuration Procedure

1. To access the Save/Restore RIP Configuration feature, go to Start >
Programs > Imation > Save RIP Configuration. The following dialog
appears:

2. Click on Save Configuration.
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3. Insert a disk into drive A as instructed and press OK. After the configuration
is saved to the disk, the following verification dialog appears.

4. Click OK, then label and store the disk in a convenient place.

2.13.2 Restore Configuration Procedure

Note: You must exit the Imation Matchprint™ Professional Server software
prior to restoring the RIP configurations.

1. To access the Save/Restore RIP Configuration feature, go to Start >
Programs > Imation > Save RIP Configuration. The following dialog
appears:

2. Click on Restore Configuration.

3. If the Imation Matchprint™ Professional Server is still running, the
following message appears. Exit the software and resume this procedure.
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4. Select which items you wish to restore from the following dialog, then click
OK.

5. When the configuration is restored, the following verification dialog appears:

6. Click OK.
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2.14  Web Interface for Clients

Client workstations can view the Imation Matchprint™ Professional Server job
queue, job log and system log through a Web user interface using any browser.

Launch the Imation Matchprint™ Professional Server web interface through your
Internet browser by accessing

http://your IMPS machine name or IP address/webui.exe

Note: See your system administrator to obtain the Imation Matchprint™
Professional Server machine name or IP address.

Web interface features:

• Job queue, job log, and system log information accessible from navigation
bar.

• Job parameters can be viewed by clicking a row in the job queue.

• Job queue color-coding gives a quick visual reference for good status (green)
and error status (red).

Green indicates normal operation such as waiting for printer.
Bright Green indicates job is RIPing or printing.
Red indicates an error situation the user could fix, such as paper is out.
Bright Red indicates a non-recoverable job error occurred.

• Link to download the Macintosh PPD installer is located at the bottom of
navigation bar.

• Link to on-line user document is also located at the bottom of the navigation
bar.

Note: If Netscape™ is your browser, make sure to set the Variable Width Font
to 10-point font for optimum web viewing. To do this, open Netscape, then go to
 Preferences-> Appearance -> Fonts.
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2.15  Web Setup Instructions

The Web interface is already setup when you receive your system. However, if for
some reason you must reload the Imation Matchprint™ Professional Server
software, the system administrator must setup the Web interface as follows:

1. Install the Imation Matchprint™ Professional Server software.

2. Install Windows NT®  4.0 Option Pack. (This Option Pack is provided with the
software that came with your Windows NT®  server software.):

a. Find the Windows NT4 Option Pack folder located on your installation
CD.

b. Run setup.exe.
c. Press yes at the service pack warning dialog.
d. Press Next and Accept.
e. Press Minimum Install.
f. Press Next, then wait for the files to finish loading.

3. Create a new web site:

a. Select Start -> Program Files -> Windows NT 4.0 Option Pack -> Microsoft
Internet Information Server -> Internet Service Manager.

b. Open the IIS folder\machine\default web site.

c. Right-click on default web site and select Stop.

d. Right-click on the machine name and select new -> web site.

e. Type imps web site for site description, then press Next.

f. Press Next.

g. Browse to .. \Imation\Imation Matchprint Professional Server\Web Interface,
then press Next.

h. Allow Read Access, Script Access and Execute (Including Script) permissions,
then press Finish.

i. Right-click on imps web site and select Properties.

j. Select the Documents tab. Add webui.exe as a default document name, then
click on Ok.
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4. Add a virtual directory named docs:

a. Right-click on imps web site and select new -> virtual directory.

b. Type docs for the alias name.

c. Browse to .. Imation\Imation Matchprint Professional Server\Documentation\,
then click on Next.

d. Allow Script Access and Read Access, then click Finish.

5. Add a virtual directory named ppd:

a. Right-click on imps web site and select new -> virtual directory.

b. Type ppd for the alias name.

c. Browse to ..Imation\Imation Matchprint Professional Server\Mac PPD, then
click on Next.

d. Allow Script Access and Read Access, then click Finish.

e. Right-click on imps web site and select Start.

6. Save settings by quitting the Internet Service Manager console and select to save
your settings.

7. Test the new web site:

a. Open a browser on the server and enter the url http://localhost/webui.exe or
http://localhost/. If the web page loads, you're done. If the web page doesn't
load, see the following Important Troubleshooting Tips.

b. Once the web site is working, client users can access the site over your
intranet using the address: http://[machine ip]/webui.exe or http://[machine
ip]/.

Important Troubleshooting Tips!

If you normally load web pages through a proxy server, make sure your
browser is set to bypass the proxy server for local web pages on the intranet.
To do this in Internet Explorer, open the Internet options dialog, go to the
Documents tab, and check Bypass proxy server for local (Intranet addresses).

If you don't know the machine's IP address, open a DOS window and type
ipconfig. The machine's ip address is shown next to the IP Address.
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2.16  Adding Custom ICC Profiles

1. Add custom ICC profiles to the Imation Matchprint™ Professional Server by
copying the files to c:/Program Files/Imation/Imation
Color/Profiles/Destination or Source.

2. Exit the Imation Matchprint™ Professional Server software and restart to
access the custom ICC profiles.

2.17  Client Printing to LPR

Line Printer Remote, also called LPR client or WLPR for Windows, is a platform
independent software that sends job to a printer or a print queue.

The following procedures include LPR client setup for:

• Windows® 2000 LPR Setup

• Windows NT® LPR Setup

• Windows® 95/98 LPR Setup

• Macintosh® LPR Setup
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2.17.1 Windows® 2000 LPR Setup

Print Services for LPR

Note: The Windows® 2000 CD-ROM is required to complete this procedure.
Locate this CD-ROM prior to beginning this procedure.

1. If not already done, setup a spooler on the Imation server prior to starting
this procedure.

2. Select Start >> Settings >> Control Panel.

3. In the Control Panels window, click on Add/Remove Programs. The
Add/Remove Programs window appears.

4. In the left section of the Add/Remove Programs window, click on
Add/Remove Windows Components.

5. On the line, Other Network File and Print Services. Leave the checkbox
blank and highlight the line.
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6. Click on Details.

7. When the details window for Other Network File and Print Services appears,
select the checkbox beside Print Services for Unix.

8. Click OK.

9. If you are prompted to insert the Windows 2000 CD, insert the disk and follow
the screen prompts to install the necessary software.
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10. When the Windows Components window reappears, a check appears in the
box beside Other Network and Print Services.

11. Click Next. The system loads the appropriate files.

12. Click Finish and Close.

LPR Port Setup

Notes:

The Imation Matchprint Professional Server software CD-ROM is required to
complete this procedure. Locate this CD-ROM prior to beginning this procedure.

If not already done, setup a spooler on the Imation server prior to starting this
procedure.

1. Select Start >> Settings >> Printers. Click on Add Printer.

2. At the Welcome screen, click Next.

3. When the Local or Network Printer window appears, select Local printer. Be
sure to de-select Automatically detect and install my Plug and play
printer.

4. Click Next. The Select the Printer Port window appears:
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5. Select the Create a new port button, then choose LPR Port from the drop-
down list. (If LPR Port is not one of the selections, go back to the beginning of
this section and complete the steps in Print Services for LPR.

6. Click Next. A window appears for entering a print server and printer name.

7. Enter the Imation print server IP address in the first field and the name of the
Imation spooler in the second field. (The printer spooler must be setup on the
Imation server to connect.)

8. Click OK.

9. Insert the Imation Matchprint Professional Server software CD-ROM into
the drive and click Have Disk…
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10. Click Browse and navigate to the CD-ROM drive. Locate Windows
LPR/WIN2000 folders and select the IMNDC12.INF file.

11. Double-click on the IMNDC12.INF file. The Xerox DocuColor12 (Imation)
printer appears in the Add Printer Wizard printer list.

12. Select Imation as the Manufacturer.

13. Click Next.
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14. Enter a new printer name or leave the default.

15. Click Next.

16. At the Printer Sharing window, select to share or leave the default.

17. Click Next.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 200158

18. Select Yes if you want to print a test page now.

19. Select Next. The completion window summarizes your printer setup
selections.

20. Verify your settings, then click Finish.
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2.17.2 Windows NT® LPR Setup

Notes for TCP/IP Setup:

• The Windows NT® CD-ROM and any service pack CD-ROM is required to
complete this procedure. Locate this CD-ROM prior to beginning this
procedure.

• TCP/IP Print Services must be running on the Imation server and the client
workstation. The Imation server is setup to always launch this software.
However, the client workstation needs to be checked to ensure TCP/IP Print
Services is loaded and started prior to setting up the LPR port.

If the TCP/IP Print Services is not loaded on your client machine, complete the
following steps:

1. If not already done, setup a spooler on the Imation server prior to starting
this procedure.

2. Go to Start >> Settings >> Control Panel and double-click on the Network
option.

3. Select the Services tab and then select the Add button.

4. In the Network service window, double-click on the Microsoft TCP/IP
Printing.
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5. Insert your Microsoft Windows NT Workstation/Server CD-ROM and select
Continue. This loads the necessary files.

When the system is done loading files, you will now see Microsoft TCP/IP
Printing in the Network Services List as shown in the following screen.

1. Close the Network window and select Yes to restart your computer.

2. After you are done installing the TIP/IP software, Microsoft recommends
reloading Service Packs. Do not proceed with these instructions until the
Service Pack has been reinstalled.
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LPR Port Setup

Notes:

• The Imation Matchprint Professional Server software CD-ROM is required
to complete this procedure. Locate this CD-ROM prior to beginning this
procedure.

• If not already done, setup a spooler on the Imation server prior to
starting this procedure.

1. Select Start >> Settings>> Printers >>Add Printer.

2. Double-click on the Add Printer icon.

3. Make sure My Computer is selected, and click Next.
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4. Select LPR Port, then click New Port.

5. Enter the Imation print server IP address in the first field and the name of the
Imation spooler in the second field. (The printer spooler must be setup on the
Imation server to connect.)

6. Click OK.

7. Click Close to close the Printer Port window.
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8. If not already selected, select the new LPR port. Click Next.

9. Insert the Imation Matchprint Professional Server software CD-ROM and
then click Have Disk…

10. Click Browse and navigate to the CD-ROM drive. Locate Windows LPR/WINNT
folders and select the IMNDC12.INF file.

11. Select the IMNDC12.INF file and click Open.
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12. Change the printer name or leave the default. Then click Next.

13. At the printer sharing window, select to share or leave the default. Click
Next.

14. Select Yes if you want to print a test page now. Then click Finish.
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2.17.3 Windows® 95/98 LPR Setup

Windows® 95/98 LPR Setup Notes:

• Imation does not support WLPRspooler on Windows® 95/98 systems.

• TCP/IP Print Services must be running on the Imation server. The server
is setup to always launch this software.

• ACITS software is required for Windows® 95/98 LPR setup. To download
ACITS software, go to
http://www.utexas.edu/academic/otl/software/lpr/acitslpr.html

• The following procedure requires the Imation Matchprint Professional
Server software CD-ROM. Locate this CD-ROM prior to beginning this
procedure.

1. If not already done, setup a spooler on the Imation server prior to starting
this procedure.

2. Select Start >> Settings >>Printers.

3. Double-click on Add Printer.
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4. At the Add Printer Wizard begin window, click Next.

5. Make sure Local printer is selected, then click Next.
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6. Insert the Imation Matchprint™ Professional Server software CD-ROM
and then click on Have Disk…

7. Click Browse and navigate to the CD-ROM drive. Locate Windows LPR Printer
folder, then the Windows folder. Locate and select the IMNDC12.INF file.

8. Double-click on the IMNDC12.INF file. The Xerox DocuColor12 (Imation)
printer appears in the Add Printer Wizard printer list.

9. Click Next.
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10. Select the LPR printer port and click Next.

11. Enter a new printer name or leave the default. Select Yes or No to set this
printer as the default or not.

12. Click Next.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 2001 69

13. Select No to printing a test page at this time, then click Finish.

The system installs any required printer drivers and creates the printer icon.

14. Right-click on the new printer icon in the Printers Folder and select
Properties.

15. Click on the Details menu tab, then on the Add Port button.

16. Select the Other radio button and select ACITS LPR Remote Printing. Click
OK.

17. Fill out the printer information. Click OK.

18. Click on the Spool Settings button.

19. Make sure the Spool print jobs so program finishes printing faster and
Start printing after the last page is spooled radio buttons are selected.

20. In the Spool data format combo-box, make sure the data format of the
printer output is set to RAW.

21. Make sure the Disable bi-directional support for this printer radio button
is selected. This option is grayed-out or missing for some printers.

22. Click OK to return to the Properties dialog and then click OK to save your
printer settings.

The printer is now configured for ACITS LPR Remote Printing.
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2.17.4 Macintosh® LPR Setup

In order to print from a Macintosh® client to the Imation Matchprint® Professional
Server on a LPR network, the client must use the Apple’s Desktop Printer Utility.

1. If it hasn't already been done, add a spooler to the Imation Matchprint®
Professional Server and install the Macintosh® Client PPD.

2. Find and launch Apple’s Desktop Printer Utility.

If you are using OS 8.6 or  9.04, the utility can be found at Macintosh Hard
Drive: Apple Extras folder: Apple LaserWriter Software: Desktop Printer
Utility. If you are using OS 9.1, the utility can be found at Macintosh Hard
Drive: Applications (Mac OS 9): Utilities: Desktop Printer Utility.

Mac OS 8.6 through 9.0.4

_

Mac OS 9.1
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Once the Desktop Printer Utility is launched, the following window appears:

3. Select the AdobePS driver from the list box and then the Printer (LPR)
option from the Create Desktop... list. (To create a desktop printer, Imation
recommends using the AdobePS driver.)

4. Click OK. A new window opens and prompts you to select both a PostScript
Printer Description file and your LPR Printer.

5. Click on the Change button for the PostScript Printer Description (PPD) File
and highlight the DocuColor12 (Imation) printer. Then click on Select.
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_

6. Click on the Change button for the LPR Printer Selection, then enter the
Imation server IP address and Queue or spooler name. _

You may select the Verify button to make sure that you have entered the
correct information. Select OK when finished.

7. Click on Create.

8. In the Save desktop printer as: field, enter a new name for the printer,
then click on the Save button.
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_

A new dialog window opens showing the progress while the Macintosh® client
creates a new desktop printer.

_
When the Saving desktop printer dialog window disappears, a new desktop
printer icon appears on your Macintosh® client.
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2.18  Menu Functions

The Imation Matchprint™ Professional Server menu bar contains options for
setting up, maintaining and operating the RIP software.

• File contains commands that direct overall print server operation.

• Queue contains commands that control queuing and proofing of jobs.

• View allows you to view the Job and System Logs, and the RIP and Printer
Status windows.

• Input allows you to add and customize Hot Folders and Print Spoolers.

• Printer allows you to add and customize your printer.

• Help allows access to the "About" Box and the User's Guide.
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2.18.1 File Menu

The File menu allows you to direct print server operation.

• Print File allows you to specify a file for proofing directly from the print server,
set its print options (i.e., Color Target, Sharpness, etc.) and submit the job for
proofing.

• Color Target Adjustment allows you to modify color targets. This feature
allows for moderate adjustments to standard color targets in such areas as dot
gain compensation. Only use this option if you are simulating conditions other
than the conventional Imation Matchprint™ Professional Server proofing system
conditions.

• Grayscale Target Adjustment allows you to modify the intensity of black ink
for grayscale printing.

• Separation Management is used to review supplied color libraries (such as
PANTONE™) and create and maintain custom color libraries.

• Preferences allows you to customize a variety of application options, such as:
where to save spooled or RIP'ed files, how long to keep spooled files, whether or
not to save RIP'ed proof images, or when to purge files by setting a specified disk
space limit.

• Print Summary Info prints out summary information for defined input and
output method, namely: hot folders, spoolers, and printers. Once the Print
Summary Info menu item is selected, the summary output is sent directly to
the job queue to be RiP'ed and printed.

• Clear Job Log allows you to discard the contents of the Job Log.

• Clear System Log allows you to discard the contents of the System Log.
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• Export Job Log... allows you to export the job log into a .txt tab-delimited file.
The file can then be imported into an Excel spreadsheet.

• Exit allows you to exit the Imation Matchprint™ Professional Server software
application. The application places any active jobs on hold when Exit is selected.
If there are any active jobs, the application prompts the user prior to exiting the
application.
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2.18.2 Queue Menu

The Queue menu allows you to control the queuing and proofing of jobs.

The following Queue menu items toggle between functions:

Hold/Release

Edit Parameters/View Parameters

Stop Spooling/Resume Spooling

Stop RIP'ing/Resume RIP'ing

Stop Proofing/Resume Proofing

• Proof Next moves the selected job to the top of the job queue allowing the job
to be processed after the currently active job is complete.

• Delete deletes any currently selected jobs.

• Hold/Release places selected jobs on hold or releases them if currently in a
held state.

• Edit/View Parameters allows you to edit or view the parameters of a selected
job in the queue. See also Setting Job Parameters.

• Stop/Start Spooling allows you to stop or start all spooling. An individual
spooler can be stopped by unchecking the Active button in the spooler
parameters dialog box.

• Stop/Start RIP'ing allows you to stop RIP'ing new jobs in the queue. Spooling
continues and jobs wait in the Saved Jobs directory until RIP'ing is enabled.

• Stop/Start Proofing stops the software from proofing any RIP'ed jobs in the
queue. Spooling and RIP'ing still occur. RIP'ed pages wait in the RIP'ed Pages
directory until proofing is enabled.
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2.18.3 View Menu

The View menu allows you to toggle the use of the status bar on/off, view the RIP or
printer status windows, and view the job or system log windows.

• Status Bar toggles the status bar on and off at the base of the application.

• RIP Status displays the status of all RIPs that are currently in use by the
application.

• Printer Status displays the status of the printer.

• Job Log displays information on processed jobs.

• System Log displays information about the status of the Imation
Matchprint™ Professional Server software and historical information that
can be used for problem tracking.

2.18.4 Input Menu

The Input menu allows you to add and customize Hot Folders and Print Spoolers.

• Add Hot Folder lets you create Hot Folders. Items placed in a Hot Folder are
automatically processed and printed by the Imation Matchprint™ Professional
Server software. Multiple hot folders can be set up to allow for different print
settings.

• Add Spooler lets you create network printers that allow for different print and
color management settings. Items sent to the spooler are automatically
processed and printed by the Imation Matchprint™ Professional Server
software. Multiple spoolers can be set up to allow for different print settings.

Note: An icon with an "X" across it indicates that the input item is currently not
active.
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2.18.5 Printer Menu

The Printer menu allows you to add and customize your Xerox® DocuColor 12™
printer.

Once you've added the printer, the Printer menu displays the new printer in the
drop-down menu.

Note: The printer name is determined by the user.

Clicking on the printer name, pulls up Printer Settings for that printer. See Printer
Setup for more information.

2.18.6 Help Menu

The Help menu allows you to access the following information:

About Imation Matchprint™ Color RIP contains copyright and version
information.

Read the User's Guide launches the on-line help.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 2001 81

3 Installing Software

Your Imation Matchprint™ Professional Server system comes with software pre-
installed. However, software installation instructions are provided in case software
needs to be reloaded or updated.

Installing the Imation Matchprint™ Professional Server software automatically
creates the folder "Imation Matchprint™ Professional Server" on the selected
installation drive. This folder contains the server software, color matching tables, and
support files. Also, the "Plugins" subfolder contains printer description files.

Note: The Imation Matchprint™ Professional Server software CD-ROM is
packaged with your system setup materials.

Important! On Imation Matchprint™ Professional Servers, Windows NT®
Server Version 4.0 is installed and then Service Pack 6a is applied. If Services
for Macintosh™ are applied after this is done, the Service Pack must be
reapplied.

3.1 Installing the Software

Important: You must be logged on as the system administrator to install the
software.

1. Insert the CD-ROM. If the installer launches automatically, go to step 3.

2. Select Run from the Start menu. The Run window displays. Enter your CD-
ROM drive letter, then enter: \install\setup.exe

OR -

Double-click Setup.exe file from the Explorer window.

A message displays asking if your system is ready for Imation Matchprint™
Professional Server software.

3. Choose the Setup Language from the drop-down list box, then click OK.

4. A message appears asking if you would like to change the system file boot.ini.
Select Yes to proceed.

5. The Imation Matchprint™ Professional Server software Welcome window
displays. Click Next>. The software license agreement window displays.

6. Click Yes to agree with the license statement and continue software
installation. The Choose Destination Location window displays.

7. The default directory and drive are listed. If desired, select a different drive
by clicking Browse... and selecting a different drive.

8. Click Next>. The Select Program Folder window displays.
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9. The default program folder is listed. If you want to change folders, enter the
name of the folder in which to place the Imation Matchprint™ Professional
Server software icons.

10. Click Next>. A progress bar displays during installation. When all files are
copied, the readme window displays. Select Yes to view the readme file.

11. The Setup Complete window displays. Select Yes, I want to restart my
computer now and click Finish. Your computer restarts allowing you to use
your Imation Matchprint™ Professional Server software.

Important! If for any reason the installation fails, reboot the server and try
installing the software again.

Boot Configurations

The Imation Matchprint™ Professional Server has been configured at the factory
for optimum performance. When booting the Imation Matchprint™ Professional
Server, two configuration choices are provided: Imation Matchprint Professional
Server and Windows NT® Server Version 4.00 [VGA mode]. The Imation
Matchprint Professional Server is the default boot configuration and should be used
in all cases except when experiencing problems with the NT video drivers.

The Imation Matchprint™ Professional Server is shipped with a total of 512 Mb
of physical RAM installed. The default boot configuration is set to allocate 128 Mb
RAM for the Windows NT® operating system and 384 Mb for the Imation
Matchprint™ Professional Server. These numbers are necessary to allow the
Imation Matchprint™ Professional Server to run.

RAM allocation is based on the following: The interface card to the Xerox DocuColor
12 needs enough RAM to hold a four-color (CMYK) bit map of a 12 inch x 18 inch
image at 600 dpi x 600 dpi in memory at one time. This translates into about 310
Mb. This amount is increased to 384 Mb to allow the Imation Matchprint™
Professional Server to run at optimum performance. The remaining 128 Mb of RAM
is allocated to the Windows NT® operating system and the Imation Matchprint™
Professional Server application for a total of 512 Mb of RAM.

For both boot configurations, Windows NT® will be allocated 128 Mb of RAM. While
in VGA mode, 384 Mb of RAM is still allocated to the Imation Matchprint™
Professional Server to allow the application to function properly although some
drivers (i.e., the NT video drivers) may not be functioning properly.

It is recommended that users not alter the boot configurations.
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3.2 Installing PPDs on Client Machines

Once the software is installed, Postscript™ Printer Driver (PPD) installation may be
necessary to allow client Macintosh® or PC computers to properly print to the
Xerox® DocuColor 12™ copier over the network. Client workstations can be Windows
NT®, Windows® 95/98, or Macintosh® systems.

The Imation Matchprint Professional Server software includes the latest version
of the AdobePS driver. Microsoft® Windows client machines wishing to print to the
Imation Matchprint Professional Server automatically install the AdobePS driver
when the printer is added via the Windows "Add Printer" dialog.

Macintosh® client machines must install the driver and PPD from either the Imation
Matchprint Professional Server CD-ROM or from the Imation server itself.
Macintosh® users must first run Stuffit Expander to unstuff the Mac-Doc12-PPD-
Installer.bin before launching the Imation PPD and AdobePS driver.

Depending on your client workstation setup, select the appropriate PPD installation
from the following:

Windows NT® or Windows 2000® Client PPD Installation

Window® 95/98 Client PPD Installation

Macintosh® Client PPD Installation

3.2.1 Windows NT® or Windows® 2000 Client PPD

Two modes of imageable print areas are supported by the Imation Matchprint™
Professional Server system, expanded and normal. On initial setup, clients adding
printers will automatically capture the current mode associated with the IMPS
system. After the initial setup, if the IMPS server administrator switches the
imageable print area, clients will need to delete existing IMPS client printers and add
new ones. Adding new printers will reflect the new print area mode.

Steps 1-11 are instructions to add a printer on initial Imation Matchprint™
Professional Server system setup. Steps 12-18 provide instructions for re-adding a
printer once the imageable print area has been changed.

1. At the Imation Matchprint™ Professional Server, set up the print spooler
where the client machine will print.

Note: When creating a spooler to be used in a mixed Operating System
environment, remember that Windows® 95/98 require the spooler name to
be 12 characters or less (alpha-numeric characters and spaces are
allowed).

2. At the client Windows machine, either log into the same domain as the Imation
Matchprint™ Professional Server, or connect to the Imation Matchprint™
Server with a valid user name and password that has a minimum of read access.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 200184

For security purposes, Imation does NOT recommend enabling the Guest
Account.

Failure to do so will result in Windows 2000 clients receiving the following error
message when trying to print an image: "Could not complete the print
command because the selected printer driver could not be found. Please
select a printer from the control panel and try again."

Workgroup Environment Considerations: In a Workgroup environment, the
Imation Matchprint™ Professional Server must be a member of the same
workgroup as the client workstations.

3. At the Start button, select Settings, then Printers.

4. Double-click on Add Printer.

5. With the Network printer server selected, click on Next.

6. Using the Add Printer Wizard, browse to the location of the RIP print server
and select the spooler created in step 1.

7. Click OK.

8. Select Yes to have this printer set as your default printer. Click Next. A message
appears saying the printer has been successfully installed.

9. Click on Finish. The printer is now added to your system.

10. Using the Windows client design application, choose Page Setup. Click Printer
and select the spooler name as created in step 1. Note that the Printer Where
location reflects the RIP's spooler pathname. Click OK.

11. Click OK to close the Page Setup dialog box. You are now ready to print.

Note: Some design applications require the print spooler to be selected as the
default printer. Failure to select the Matchprint™ Professional Server as the
default printer may not allow your design application to print to the Xerox®
DocuColor 12™. The following type of error might appear, "Could not complete
the Page Setup command because the selected printer driver could not be found.
Please select a printer from the control panel and try again."

If you get this type of error, change the default printer in your Printer Control
Panel. Click on Start>Settings>Printers. Click once on the Matchprint™
Professional Server print spooler name and click File - Set as Default. Launch
your design application, open the file to print, and either select to print or choose
Page Setup and select the Matchprint™ Professional Server print spooler.

Re-adding Printers for Imageble Area

12. Restart the client system.

13. Delete all printers from the client.
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14. Delete all files and folders within winnt\system32\spool\drivers\w32x86.

15. At the Imation Matchprint™ Professional Server, install the selected image area.
(This is located in c:\Program Files\Imation\Imation Matchprint Professional
Server\Print Area Setups.)

16. At the Xerox DocuColor 12, install the selected image area. (See Xerox DocuColor
12 User’s Guide.)

17. Restart both the client and Imation Matchprint™ Professional Server systems.

18. Add the new printer at the client. (See steps 1-11 of this procedure.)

Note: When adding the printer after changing the image area setting, it may
takeup to 15 minutes for it to show up on the system.
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3.2.2 Windows® 95/98 Client PPD

Two modes of imageable print areas are supported by the Imation Matchprint™
Professional Server system, expanded and normal. On initial setup, clients adding
printers will automatically capture the current mode associated with the IMPS
system. After the initial setup, if the IMPS server administrator switches the
imageable print area, clients will need to delete existing IMPS client printers and add
new ones. Adding new printers will reflect the new print area mode.

Steps 1-15 are instructions to add a printer on initial Imation Matchprint™
Professional Server system setup. Steps 16-22 provide instructions for re-adding a
printer once the imageable print area has been changed.

1. At the Imation Matchprint™ Professional Server, set up the print spooler
where the client machine will print. Keep spooler names to 12 characters or less.
Windows® 95/98 require the Spooler name be 12 characters or less. (Alpha-
numeric characters and spaces are allowed).

2. At the client Windows® 95/98 machine, log into the same domain as the
Imation Matchprint™ Professional Server.

Note: If when trying to add a printer, the Imation server requests a password,
but does not allow the user to log in as a guest, the Imation server
administrator must set the User Manager for Domains Guest properties to a
blank password and check Password Never Expires. This allows the
Windows® 95/98 client workstation to add the Imation spooler as a printer.

Workgroup Environment Considerations: In a Workgroup environment,
the Imation Matchprint™ Professional Server must be a member of the
same workgroup as the client workstations.

3. At the Start button, select Settings, then Printers.

4. Click on Add Printer.

5. Click on Next.

6. Select Network printer.

7. Click on Next.

8. Browse to the location of the Imation Matchprint™ Professional Server and
select the spooler created in step 1.

9. Under the text, "Do you print from MS-DOS based programs?," leave No
selected.

10. Click on Next.

11. Edit the printer name, if desired. A default printer name based on the printer
driver is automatically entered. However, you can type in a more descriptive
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name. The name you type only appears on this Window® 95/98 client
workstation.

12. Click on Next.

13. A dialog box appears asking if you want to print a test page. If you select Yes,
another dialog box appears asking if it printed successfully. If it did print
successfully or you answered No to print a test page, drivers are copied and a
window appears showing the added printer.

14. Using the Windows® 95/98 client design application, choose Page Setup. Click
Printer and select Xerox® DocuColor 12™. Note that the Printer Where
location reflects the RIP's spooler pathname. Click OK.

15. Click OK to close the Page Setup dialog box. You are now ready to print.

Re-adding Printers for Imageable Area

16. Restart the client system.

17. Delete all printers from the client.

18. Delete the Imxdoc12 PPD file within windows\system.

19. At the Imation Matchprint™ Professional Server, install the selected image area.
(This is located in c:\Program Files\Imation\Imation Matchprint Professional
Server\Print Area Setups.)

20. At the Xerox DocuColor 12, install the selected image area. (See Xerox DocuColor
12 User’s Guide.)

21. Restart both the client and Imation Matchprint™ Professional Server systems.

22. Add the new printer at the client. (See steps 1-15 of this procedure.)

Note: When adding the printer after changing the image area setting, it may take
up to 15 minutes for it to show up on the system.
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3.2.3 Macintosh® Client PPD

The Macintosh® client PPD is available to download using the Imation
Matchprint™ Professional Server CD-ROM, from the Imation Matchprint™
Professional Server Web User Interface (UI), and directly from the Imation
Matchprint™ Professional Server.

Loading PPD from the CD-ROM

1. Determine which mode of Printer Image Area (Normal or Expanded) the
Imation Matchprint™ Professional Server is operating.

2. It is recommended that any virus protection software be disabled before you
use the Mac-Doc12-PPD-Installer.

3. Insert the Imation Matchprint™ Professional Server CD-ROM. An icon for
the CD-ROM appears on your desktop.

4. Double-click on the CD icon.

5. View the two folders, Expanded and Normal, in the displayed window.

6. Double-click on the appropriate folder to view the Mac-Doc12-PPD-
Installer and Install Imation PPD Readme files.
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7. Double-click on the Mac-Doc12-PPD-Installer. The associated Readme dialog
displays. Select the Continue button. The following dialog displays.

Select the Install button to install the Imation PPD for the Xerox
DocuColor12. When PPD installation is complete, the following dialog displays:
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8. Imation recommends using the AdobePS printer drivers. Click on Yes if you
wish to do so. The following dialog appears:

Select OK and the following dialog displays:

9. Click on Quit. The AdobePS installer screen appears. Select Continue to
begin the installation of the AdobePS drivers.
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A new installer window opens displaying the AdobePS Installer:

10. Click on Install. When installation is complete, the following dialog appears:

11. Click on Quit, if you are done installing.

Downloading PPD from the Web User Interface

1. Determine which mode of Printer Image Area (Normal or Expanded) the
Imation Matchprint™ Professional Server is operating.

2. Access the Imation Matchprint™ Professional Server Web User Interface
using a web browser.

3. Click on the Download Mac PPD Installer link in the left frame of the
window.

Note: This is a compressed file. If your web browser is not configured to
automatically decompress files, locate the downloaded file Mac-Doc12-PPD-
Installer.bin and use a decompression application similar to Stuffit
Expander™ to decompress the file.

4. Continue with step 6 in the Loading PPD from CD-ROM procedure.
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Loading PPD from the Imation Matchprint™ Professional Server

1. Determine which mode of Printer Image Area (Normal or Expanded) the
Imation Matchprint™ Professional Server is operating.

2. Have the Imation Matchprint Professional Server administrator create a Mac
Share for the folder c:\Program Files\Imation\Imation Matchprint Professional
Server\MAC PPD.

3. At the Macintosh client, navigate to the Imation Matchprint Professional
Server and then to the c:\Program Files\Imation\Imation Matchprint
Professional Server\MAC PPD.

4. Copy the MAC PPD folder to your Macintosh computer.

5. Follow step 5 in the Loading PPD from CD-ROM procedure.

Macintosh® Client Setup

1. At the Imation Matchprint™ Professional Server, set up the print spooler
where the client machine will print. Go to Adding a Spooler located under
Getting Started for additional information.

2. In the Chooser, click on the Adobe PS printer icon in the left column. This
displays a list of compatible PostScript printers in the right side of the
window.

3. Double-click on the desired spooler.

A set up window appears and the Chooser tries to locate the correct PPD from
the PPD folder.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 2001 93

If the Chooser cannot determine which PPD file to use, or if the Select PPD
Button is clicked on, another window opens and you are prompted to select a
PostScript™ Printer Description file from the PPD folder.

4. Click on the DocuColor12 (Imation) PPD and then click on the Select button.

A set up window appears showing, "Status: selecting the printer description
files."

 

Once the PPD is selected, another dialog opens and prompts you to set the
installable options.
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5. Choose the options from the drop-down menus appropriate for your
configuration. Click on the OK button when finished. A final status window
appears showing, "Building Desktop Printer."

When complete, an icon for the selected printer appears on your desktop.
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4 Print Management

4.1 Job Printing

The Imation Matchprint™ Professional Server software allows the direct printing
of CMYK, TIFF, TIFF/IT, Adobe Photoshop™ CMYK and RGB images, Scitex™ CT
images, PDF (portable document format), PostScript™, and Encapsulated
PostScript™ (EPS) files.
To print a job from the print server:

1. Select Print File from the File menu. A file selection dialog box displays.

2. Browse to the file you want to print and select the file.

The Print File dialog box displays with the following tabs: Printer, Color,
Output, PDF, Preview and Summary.

To view tab information, go to Setting Job Parameters, located under
Getting Started.

Note: For PostScript jobs submitted via a Print File, job parameter settings for
Number of Copies, Input Tray and Media Type override the PostScript file codes.
For all other settings, the PostScript file settings override the job parameter
settings.

For jobs submitted through a spooler or hot folder, the values in the Postscript
file always override the default job parameters for that spooler or hot folder.
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4.2 Printing from a Hot Folder

Hot Folders are folders the Imation Matchprint™ Professional Server software
"watches" for incoming jobs. When a file of a supported file type is placed in a Hot
Folder, it is automatically entered into the job queue for proofing. When a file enters
the Hot Folder, it is given the default Hot Folder Settings (i.e., color target, etc.) set
for the particular folder it is placed in.

Important!

If when first creating/selecting a Hot Folder, it already contains files, a dialog
displays a warning that processed files will be deleted.

All Files placed into a Hot Folder are DELETED after proofing! To send a copy of
a file on your Mac, press the Option key (Ctrl on Windows NT®), click on the
desired file, and drag it to the Hot Folder. The original file will remain in its
folder, and the copy will be deleted.

Note: For PostScript jobs submitted via a Print File, job parameter settings for
Number of Copies, Input Tray and Media Type override the PostScript file codes.
For all other settings, the PostScript file settings override the job parameter
settings.

For jobs submitted through a spooler or hot folder, the values in the Postscript
file always override the default job parameters for that spooler or hot folder.

Hot folders are useful in a single system configuration, where the computer, acting
as the print server, also serves as a workstation. When printing from your application
on the print server, save the file to your Hot Folder. The file is automatically proofed
and then deleted. This saves you the steps of selecting the file to be proofed in the
Imation Matchprint™ Professional Server software, then deleting the file later
after proofing. Hot Folders are also useful when files are being produced by an Open
Prepress Interface (OPI) system or some other automated means.
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4.3 Network Job Printing

Imation Matchprint™ Professional Server software allows you to print files from
any workstation that is networked with the Professional Server. This is accomplished
using a spooler (see Adding a Spooler for information on setting up a spooler). In
your workstation application (i.e., Adobe Photoshop™, QuarkXPress™, etc.), simply
select the spooler as your printer and print as you normally would. Files that are sent
to the Spooler are automatically entered into the Job Queue for proofing.

Postscript™ Printer Driver (PPD) installation may be necessary to allow client
Macintosh® or PC computers to properly print to the Xerox® DocuColor 12™ copier
over the network.

The Imation Matchprint Professional Server software includes the latest version
of the AdobePS driver. Microsoft® Windows client machines wishing to print to the
Imation Matchprint Professional Server automatically installs the AdobePS driver
when the printer is added via the Windows "Add Printer" dialog. If a more recent PPD
version is detected on the server than exists on the client, the system asks if you
would like to use the newer version. Imation recommends using the newest PPD
version.  If you choose to use the older PPD, the software may not function as
expected.

See Installing PPDs on Client Machines for additional instructions.

4.4 Printing Multiple Files

This feature allows you to print a selection of files by selecting the files at the
operating system level. Make sure the Imation Matchprint™ Professional Server
software is running.

1. Locate the files on the hard drive and select them. (Use the Shift or Ctrl key
to select multiple files.)

2. Drag the selected files onto the Professional Server icon or the Job Queue
window. A Print File dialog is displayed for the selected files. Select the
desired options common to the files and click OK.

3. The files now enter the job queue. Highlight individual jobs and change
parameters, if desired.
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4.5 Printing Controls

When processing print jobs, use any or all of the menu items listed below, in any
order.

The menu items you can use to control printing are as follows:

• Clearing the Job or System Logs

• Setting Job Parameters

• Edit or View Parameters

• Proof Next

• Delete

• Hold/Release Job

• Stop/Start Spooling

• Stop/Start RIP'ing

• Stop/Start Proofing
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4.6 Color Target Adjustment

Color Target Adjustment allows you to modify color targets. This feature allows for
moderate adjustments to standard color targets in such areas as dot gain
compensation. Only use this option if you are simulating conditions other than the
conventional Imation Matchprint™ Professional Server proofing system
conditions.

Select Color Target Adjustment from the File menu to display the following:

Media: Drop-down menu displays available media selection.

Target: Drop-down menu displays adjustable profiles and device links from the
"Imation Color\Device Links" and "Imation Color\Profiles\Destination" folders.

File: Drop-down menu displays available adjustment files for the selected color
target. No drop-down menu is available if no customized file exists for the selected
target. To create one, click New.
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Settings of Cyan, Magenta, Yellow and Black: Adjustments for 6%, 25%, 50%,
75% and 100% levels. Default value for unsaved files is zero. For existing files,
default values are read from the file. For the 6% column, allowable values are -6.0
to +12.0 (not possible to remove more than 6%). For all other columns, allowable
values are -12.0 to +12.0. Clicking buttons with color names graphs those settings.

Color TIP: You might be surprised to learn that CMYK adjustments can be made to
PostScript files which contain RGB data. This is because the PostScript interpreter
converts the data from RGB to CMYK internally (using PostScript's Color Space
Arrays) before the data is processed by the Imation RIP. Thus, PostScript files follow
CMYK color workflows, not RGB, even if they contain some RGB data. See Imation
RIP Overview for details.

Density Adjustment: Density adjustment ranges from -20.0 to +20.0.

Done: Prompts the user to save changes, if changes have been made. Otherwise, no
changes are made and the dialog is dismissed.

Save: For new adjustment files, clicking on Save displays a Save As dialog box and
saves to the "Color Tables" folder. For existing adjustment files, clicking on Save
saves the current settings and no confirmation box displays.

Reset: Input fields are reset to previous values. For unsaved files, fields are reset to
zero. For saved files, values are restored from the file.

New: Creates a new color target adjustment. Input fields are set to zero.

Save As: Allows the user to save under another file name and location.

Delete: Allows the user to delete Color Target Adjustment files.
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4.7 Grayscale Target Adjustment

Grayscale Target Adjustment allows moderate adjustment of black ink for
grayscale printing.

Note: For .ps, .tif or native Photoshop (.psd), the Grayscale Target Adjustments
only apply if the image is in grayscale. If the .ps, .tif or .psd file is in color,
Grayscale Target Adjustments are ignored. For all other supported file formats,
such as .eps, .pdf, etc., the Grayscale Target Adjustments are disabled.

To adjust the gray levels of grayscale .eps, .pdf, or .dcs2 files, use the Color
Target Adjustment feature and modify the black channel or the density
adjustment as desired, then apply this Color Target Adjustment to the file.

Separations and Grayscale: If grayscale images are desired when printing
from client applications, the PostScript™ data must be sent as composite, not
separated. If this is not done, the image will print in color.

Select Grayscale Target Adjustment from the File menu to display the following:

File: Drop-down menu displays available adjustment files for grayscale printing. No
drop-down menu is available if no grayscale target adjustment files exist. To create
one, click New.
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Settings for  Black: Adjustments for 6%, 25%, 50%, 75% and 100% levels.
Default value for unsaved files is zero. For existing files, default values are read from
the file. For the 6% column, allowable values are -6.0 to +12.0 (not possible to
remove more than 6%). For all other columns, allowable values are -12.0 to +12.0.

Density Adjustment: Density adjustment ranges from -20.0 to +20.0.

Done: Prompts the user to save changes, if changes have been made. Otherwise, no
changes are made and the dialog is dismissed.

Save: For new adjustment files, clicking on Save displays a Save As dialog box and
saves to the "Color Tables" folder. For existing adjustment files, clicking on Save
saves the current settings and no confirmation box displays.

Reset: Input fields are reset to previous values. For unsaved files, fields are reset to
zero. For saved files, values are restored from the file.

New: Creates a new grayscale target adjustment. Input fields are set to zero.

Save As: Allows the user to save under another file name and location.

Delete: Allows the user to delete grayscale adjustment files.
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4.8 Viewing the Job Queue

The job queue is part of the main screen format as shown below:

The job queue window has four areas:

• Device Status

• RIP Status

• Print Status

• Job Queue

4.8.1 Device Status Area

The Device Status area in the upper left corner contains the following icons:

  Activity Indicator: The spinning "beach ball" icon indicates the software is
running properly.

Spooling: The spool icon is second. A red X through the icon indicates you
have selected Stop Spooling from the Queue menu. Workstations will not be able to
see the proofer on the network if the spooling is off. To enable spooling, select
Resume Spooling in the Queue menu.

RIP'ing: The RIP icon is third. A red X through the icon indicates you have
selected Stop RIP'ing from the Queue menu. To enable RIP'ing, select Resume
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RIP'ing in the Queue menu.

Printing: The proof icon is fourth. A red X through the icon indicates you have
selected Stop Printing from the Queue menu. To enable Printing, select Resume
Printing in the Queue menu.

4.8.2 RIP Status Area or Window

The RIP status area can be seen from the Job Queue or by selecting View > RIP
Status from the menu.

RIP/Document Name displays the RIP type and document name of the currently
selected file.

RIP Progress Bar indicates processing status for PostScript™, Scitex™ CT, TIFF,
and Adobe Photoshop™ images. (The bar is only approximate for PostScript™ files.)

Start/Elapsed Time displays the time the current file began RIP'ing as well as the
elapsed time since RIP'ing began (does not include spooling time.)

4.8.3 Print Status Area or Window

The Print status area can be seen from the Job Queue or by selecting View >
Printer Status from the menu.

Printer/Document Name displays the printer and name of the currently selected
file, if a printer has been assigned to the job.

Printer Status Message indicates current proofer status.
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Printer Progress Bar indicates the proofing status for the current file.

Start/Elapsed Time displays the time the current file began printing and the
elapsed time since printing began.

4.8.4 Job Queue Area

The Job Queue area contains information on each job in the queue, including:

• Job Status

• Document Name

• User Name

• Job Size

• Media Type

• Color Target

• Number of Pages

• Messages

Right-clicking on a selected job gives pop-up menu with portions of the Queue menu
available.

At the top of the queue is the job with the "highest" priority. Usually the status for
the highest priority is "RIP'ing" or "Proofing," unless proofing has been stopped.
When the job finishes, it disappears from the list and the other jobs move up in the
queue.

Status
The job currently arriving over the network will have a spooling status. The possible
job statuses are:

• Waiting: The job is waiting to Spool/RIP/Print.
• Spooling: The job is coming in from a workstation computer to the print

server (over the network).
• RIP'ing: The job is "Raster Image Processing."
• Hold: The job has been placed on hold, either manually or automatically due

to an error.
• Waiting for Printer: The printer is warming up or currently working on

another job.
• Printing: The printer is actively printing the job.

Notes: 1. Jobs may be in more than one of these states simultaneously (i.e.,
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Spooling/RIP'ing). 2. To manipulate a particular job (e.g., delete, hold, release or
proof next), select it by clicking on the job.

You may select a range of jobs using the Shift key while highlighting additional
jobs or use the Ctrl key to select non-contiguous sets of jobs.

4.9 Viewing the Job or System Log

Select Job Log or System Log from the View menu to view.

Job Log Screen:

The Job Log contains information on past jobs (doc name, user name, date, etc.).

Note: The job log is stored in the Configuration folder as a text file called
jlog.txt. This file is a tab-delimited text file, suitable for reading into
spreadsheets and database programs.

System Log Screen:

The System Log contains information used for technical support.

Note: The system log is stored in the Configuration folder as a text file called
slog.txt. This file is a tab-delimited text file, suitable for reading into
spreadsheets and database programs.
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4.10  Clearing the Job or System Log

Select Clear Job Log or Clear System Log from the File menu to clear the logs. A
confirmation box appears asking if you are sure you want to clear the contents of the
Log.

Clicking Yes clears the log. Clicking No retains the current log.

To save the contents of the existing job or system log (to enter data into a
spreadsheet program, for example), simply copy the job log file (jlog.txt) or system
log file (slog.txt) out of the "Configuration" subdirectory of the application's main
directory.

4.11  Proof/Print Next

You may move the priority of a job to the top of the queue as follows:
1. Select the job you want to proof next by clicking on the job in the Job Queue

window.
2. Select Proof Next from the Queue menu or right-click on the mouse and

select Proof Next from context menu. The selected job will print next.

4.12  Delete

You may delete jobs from the queue as follows:

1. Select the job(s) you want to delete. To delete multiple jobs, hold down the
Shift key when selecting the range of jobs.

2. Select Delete from the Queue menu.

Important! It is recommended you do not delete a processing job (i.e.,
spooling or printing).
 If the job is spooling, the spooling stops. The user who is sending the job

may receive an error message on the workstation computer.
 If the job is processing, it may take some time to stop, due to the

PostScript™ cleanup necessary to clear data which has already processed.
 If the job is printing, the printing will stop. The page ejects if printing has

already started.
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4.13  Hold or Release Job

The Hold menu item places the selected job(s) on hold, so they are not processed or
proofed. If the selected jobs are on hold, the menu item will change to Release.
Selecting Release changes the status of the job(s) back to Waiting, which puts
them back in the Job Queue.

1. Select the job you want to put on hold. If you want to put a range of jobs on
hold, hold down the Shift key when selecting the range of jobs.

2. Select Hold from the Queue menu OR right-click and select Hold from the
menu.

Note: You can place a job on hold while it is spooling. Once it has
completed spooling, it will immediately go on hold.

3. To release the job(s), select the job(s) and then select Release from the
Queue menu OR right-click and select Release from the menu.

4.14  Edit or View Job Parameters

Select a job in the job queue and double-click to view job parameters, OR select a
job in the job queue, then select Edit Parameters from the Queue menu, OR select
File > Print File and pick a file to proof.

The Job Parameter screen appears with the following tabs: Printer, Color, Output,
PDF, Preview, and Summary.

To view tab information, go to Setting Job Parameters, located under Getting
Started.
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4.15  Stop or Start Spooling

The Stop Spooling menu item stops the Imation Matchprint™ Professional
Server software from accepting any more network jobs. The Professional Server
software will still RIP and proof any jobs still in the queue, but does not accept any
new jobs via spooler or hot folder. (No spoolers are visible on the network and hot
folders become inactive.)

1. After selecting the Stop Spooling command, the menu item changes to
Start Spooling.

2. Select Stop Spooling from the Queue menu.

To resume spooling, select Start Spooling from the Queue menu. The software
restarts spooling and the menu item reverts to Stop Spooling. The software then
allows jobs to be received from the network.

4.16  Stop or Start RIP'ing

The Stop RIP'ing menu item stops the Imation Matchprint™ Professional
Server software from RIP'ing any job(s) in the queue.

After selecting this command, the menu item then reads Start RIP'ing.

1. Select Stop RIP'ing from the Queue menu.

2. To resume RIP'ing, select Start RIP'ing from the Queue menu. The software
restarts RIP'ing and the menu item reverts to Stop RIP'ing.

Note: The system may continue spooling, even when Stop RIP'ing is activated.

4.17  Stop or Start Proofing

Select Stop Proofing from the Queue menu to stop the Imation Matchprint™
Professional Server software from printing any jobs in the queue. This selection
allows accepting new print jobs, but will not print them.

Note: This menu item does not stop the processing of the jobs currently RIP'ing
or printing.

The Stop Proofing menu item is useful when changing the media in a proofer, or
some other maintenance on the machine. A red X over the printer icon displays in
the Status Bar of the Job Queue while proofing is stopped.

1. Select Stop Proofing from the Queue menu.

2. To resume proofing, select Start Proofing from the Queue menu. The top
job in the queue (with a status of Waiting) immediately moves to the proofing
phase and the menu item reverts to Stop Proofing.
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5 Separation Management

Separation Management is a tool to manage and maintain the color separations
contained in color libraries used by the Imation Matchprint™ Professional Server
software. Four libraries are included, the PANTONE™ Coated and Uncoated Libraries,
the Imation Matchprint™ Library, and a sample "User Colors" Library. The "User
Colors" Library contains a variety of colors to use as a starting point for customizing
your own color separations. You can also create additional custom user libraries, if
desired.

Color libraries provide color definitions for color separations by name. For example, if
you have a QuarkXPress™ document with an "Autumn Red" separation, the color
library must also contain the "Autumn Red" color definition.

Important! It is imperative the color separation name be exactly the same in
the application and in the Separation Management color library. When the
PostScript™ file is received by the Imation Matchprint™ Professional Server
software, the system identifies the separation by name, and uses it to find the
color separation data in the library. Therefore, if the exact name does not
appear in the color library, the system will not be able to process the file.

It is important to name every color differently. If you have two colors with the same
name, the Imation Matchprint™ Professional Server software will use the color it
finds first. Therefore, to avoid confusion, always use unique color names.

This section shows you how to use Separation Management to create new color
libraries, and add, duplicate, and delete colors.

Note: Any file from a design application can have up to twelve colors beyond
cyan, magenta, yellow and black.

• L*a*b* Color Space

• Creating a Color Library and Adding Colors

• Importing Colors - Tab Delimited Files

• Exporting Colors

• Editing Colors

• Copying Colors

• Deleting Colors
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5.1 L*a*b* Color Space Overview

A good understanding of the L*a*b* color space can be helpful when using
Separation Management.

L*a*b* refers to a three dimensional color space model. L* indicates on a scale of 0
to 100 the luminosity/brightness of a color ranging from dark to light; a* indicates
on a scale of -120 to +120 the appearance of a color ranging from green to red; b*
indicates on a scale of -120 to +120 the appearance of a color ranging from blue to
yellow.

Every color has a specific L*a*b* value. A spectrophotometer defines a color
according to its location in three-dimensional L*a*b* color space. For example, you
can use a spectrophotometer to measure custom color chips to determine the correct
L*a*b* values for your desired custom color.

L*a*b* Color Space
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5.2 Creating a Color Library

To add custom colors to the application, you can either create a new color library and
add colors to it, or add colors to an existing user color library. Name your color
libraries in a way that makes sense to you. For example, you could name your
libraries by color set (e.g., "Summer colors," "Winter colors") or by user name (e.g.,
"ABC company," "Karen's colors").

Note: You can only add new colors in unprotected user color libraries. The
supplied Imation Matchprint™ library and two PANTONE™ libraries are protected
and cannot be altered.

1. Select Separation Management from the File menu. The Separation
Management dialog box displays.

Use the "Color Library" drop-down box to select the desired color library. To
create a new library, go to step 2, otherwise go to step 6.

The Separation Management dialog box displays the colors contained in the
selected library. This list may contain anything from a few colors to hundreds
of colors.

2. To create a new color library, click New Library.

3. Enter the name for your new color library (e.g., "Spring Colors").
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4. Click OK. The new color library is now available/selected in the Separation
Management dialog.

5. To add colors to a color library, first select the color library you want to edit
from the Color Library drop-down menu. In our example, the "Spring
Colors" library is already selected. Note that it is currently empty, since it is
new.

6. Click New Color. The Separation Editor dialog box displays.

7. Enter your Color Name.

Warning! The color name must match exactly as it is named in the page
layout or graphic application used. When a PostScript™ file is received from
the application, the system looks through the color libraries for a separation
with the exact same name. For instance, if the name used by the graphic
application is "Autumn Red," enter "Autumn Red" here, not "AutumnRed" or
"Aut Red."

Note: Make sure the color name is unique; color names should be unique across
all color libraries. Otherwise, the first matching color found by the system will be
the one used.

8. If you know the L*a*b* values for the color (say, from spectrophotometer
readings), enter them in the 100% tint field. Otherwise, go to step 10. If you
know the numbers for the 75%, 50%, and 25% tints, enter those as well. If
you don't know the L*a*b* numbers for any of the tints other than 100%, go
to step 9.

You may also enter the L*a*b* values for the paper for greater color matching
accuracy. Figure the correct number to subtract for base by taking a
spectrophotometer reading on the white base area. This number is usually
close to 100 for L* and 0 for a* and b*.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 2001114

9. If you do not know the L*a*b* numbers for some or all of the tints other than
100%, and you would like to have the application fill them in for you, click
Compute. The software estimates the remaining tint values and fills them in.
(Note: Best color reproduction is achieved when the 75%, 50%, and 25% tint
values are measured and entered manually.) Go to step 12.

10. If you do not know any of the L*a*b* numbers for the color, click Color Picker.
The Color Picker dialog box displays.

11. Choose the best color approximation for the separation, then click OK. The
software will convert the color to L*a*b* numbers which then display in the
Separation Editor dialog box. Note that this method will not give accurate color
reproduction.

In the Separation Editor dialog box, the colored box to the right of the
separation name shows an RGB approximation of the color definition. The
application will try to reproduce this color as faithfully as possible.

12. To add the color to the library, click Save. The Separation Management dialog
box now contains the new color separation.
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13. To add more colors, repeat steps 6 through 12.
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5.3 Editing Colors

The Edit command is available only for "user" color libraries.
1. Select a color and click Edit. The Separation Editor dialog displays.

2. Make any desired changes to the data and click Save.

Color Picker, Color Wheel, and ColorSpace are color edit tools. These color
edit tools all share the same purpose, so choose the tool you prefer.

Compute: Computes values for empty fields. ("Paper" defaults to 100,0,0 if not
shown.)

Save: Saves data and exists the dialog box.

Cancel: Exits the dialog box without saving.
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5.4 Copying Colors

The Copy command is available only for "user" color libraries.
1. Select a color and click Copy Color. The Separation Editor dialog box

displays.

2. Make any desired changes to the data and click Save.
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5.5 Deleting Colors

The Delete Color command is available only for "user" color libraries.
1. Select a color and click Delete Color. A confirmation dialog box displays.

2. Click Yes to delete the color(s) from the library. Otherwise, click No.
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5.6 Exporting Colors

The Export Colors command is available only for "user" color libraries.

Using Export Colors allows you to export all the colors of the library to a tab-
delimited text file. You can then review or edit the file in another application.

Exporting to a file is also useful to backup a color library. To restore the saved color
information, use Importing Colors.

1. Click Export Colors in the Separation Management dialog box. A file
selection dialog box displays.

2. Select the desired file name and location for the color library data, then click
Save.

See Importing Colors for file format information.
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5.7 Importing Colors

The Import Colors command is available only for "user" color libraries.

Import Colors allows you to load colors from a tab- or space- delimited text file.

1. Click Import Colors in the Separation Management dialog box. A file
selection dialog box displays.

2. Select the desired tab-delimited color file and click Open.

Creating Tab-Delimited Files

Create tab-delimited files in a spreadsheet program such as Microsoft™ Excel; each
text line defines a single color. These files can then be imported into a user color
library. Each line contains the following:

• Color Separation Name (1 to 31 characters)

• Printing priority (used in old versions of the application) - use "1"

• Separation type (used in old versions of the application) - use "CMYK"

• L*a*b* color definitions for 100%, 75%, 50%, and 25% tints (floating point
numbers L[0,100] a, b [-120, 120])

• L*a*b* color definitions for the media (floating point numbers L[0,100] a, b
[-120, 120])
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Note: The three 100% tint values for L*a*b* are required; the rest of the tint
values are optional.

Each field must be separated by a single space or Tab character, and the line
must end with a hard carriage return. For example, if you have a color with the
name "Sun Yellow," and 100% tint values of "78, 23, and 34," the line would
look like this:

Sun Yellow 1 CMYK 78 23 34
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6 Roman Font Manager

The Roman Font Manager application allows you to review a list of fonts known to
the Imation Matchprint™ Professional Server, add, create aliases, or remove
fonts from the list.

To access the Roman Font Manager, go to Start > Programs > Imation > Roman
Font Manager. The Roman Font Manager dialog box appears:

The list on the left side of the Roman Font Management dialog box shows all the
Roman fonts known by the Imation Matchprint™ Professional Server. This list
many contain only a few or hundreds of fonts (Imation Matchprint™ Professional
Server contains 136 standard fonts.) Use the scroll bar to scroll through the list to
see fonts outside the current view. Typing the first few letters of a font can also
select and display the desired font.

Select a font name by clicking on the font.

The right side of the dialog box contains four command buttons.

• Install Copy of Font

• Install Alias to Font

• Delete Font

• Quit

The Quit button is always active. Close the Roman Font Manager by clicking Quit.
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6.1 Install Copy of Font

The Install Copy of Font command allows you to select fonts to copy to the font
list. Do these steps to ensure a font is always available when proofing.

1. Click Install Copy of Font to display the directory dialog. Locate the desired
Fonts folder and locate the font to be added.

2. Select a font and click Add. To select all the fonts in the folder, click Add All.
After selecting the fonts to be added, click Done. The dialog box disappears
and copies of the fonts are added to the font(s) list.

6.2 Install Aliases to Fonts

The Install Alias to Font command allows you to create a path to a font that is
stored somewhere other than the Imation Matchprint Professional Server™ folder.
Using aliases conserves disk space and allows you to avoid duplicate font files on
your system. Aliases to fonts appear in italics in the Roman Font Management dialog
box. An alias to a font is a pointer to the specified font file. In order for the alias to
work, the font file must remain in the same location as when the alias was set up.

1. Click install Alias to Font to display a directory dialog. Locate the desired
fonts folder.

2. To select a single font, highlight the font and click Add. To select all the fonts
in the folder, click Add All. After selecting the fonts to be added, click Done.
The dialog box disappears and aliases to the font(s) are added to the font list.

6.3 Delete Fonts

The Delete Font command is active when one or more font names are selected in
the font list.

Select the font(s) you want to remove from the list.

1. Click Delete Font. A confirmation dialog displays.

2. Click OK to remove fonts from the list. Click Cancel to disregard the removal
request.

Note: The fonts are removed (deleted) from the disk system. Use caution when
deleting fonts.



Imation Matchprint™ Professional Server User Guide

Imation Corp. 2001124

7 Troubleshooting and TIPs

7.1 Troubleshooting

Problem Possible Solution

Nothing comes out of
 the printer.

1. Printer problem:

 Check LCD panel for error messages. Make a
copy on the DocuColor 12 to verify it functions.

 Check input tray to make sure there is paper in
the tray.

 Make sure the paper orientation matches the
setup on the Printer tab of the Job Parameters
dialog.

2. Application problem: Check tray settings, job state,
job messages, etc., for possible error conditions.

3. Driver failure: Job won't hold. Try rebooting
application and printer.

Color output is wrong. 1. Check color target settings. Make sure settings are
appropriate for the media used.

2. Try calibrating the printer, if not calibrated already.

3. If calibration has been done and color is still
unacceptable, check ink levels.

4. Make sure the correct or intended device links have
been selected for the media. The media and color
target can be identified by printing a job slug on
the proof.

Problems viewing the
Help files.

If you are having problems viewing the Help files, update
your browser to the latest version. Most viewing problems
are corrected by doing this. The Help files were tested
using Netscape Navigator 4.08 and Internet Explorer 4.0.

Printer output is
different than what is
specified in the Job
Parameter settings.

For PostScript jobs submitted via Print File, the number of
copies (see Output tab) and the input tray selection (see
Printer tab) override the values used when the PostScript
file was created. For all other settings, such as Media
Type, Output Bin, Duplex, and Collate, the PostScript file
settings override the job parameter settings.
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For jobs submitted through a spooler or hot folder, the
values in the PostScript file always override the default job
parameters for that spooler or hot folder.

When trying to duplex
a job, the back of the
first page is blank.

If you want to reverse print while duplexing, you should
NOT use the application's "Reverse Printing" feature.
Printing odd numbered page documents with PPD options
set to "reverse print" and "duplex," and using a spooler
with "duplex on," but "collate off," causes page 1 to print
with no back page. This occurs because the application
sends the pages in reverse order. The Imation server only
sees a duplex job with an odd number of pages.
Consequently, a blank page gets tacked on after the last
page, which in this case is page 1.

AdobePS only -
Duplexing issues.

Turning duplexing on de-activates media types that do not
support duplexing. However, selecting media types that do
not support duplexing does not turn off the duplexing
option.

Selecting a media that shouldn't duplex, then turning on
duplexing, does not disable the non-duplexing media. To
resolve this issue, turn duplexing off, select Normal Bond
and then turn duplexing back on.

All my hot folder jobs
are gone!

If when first creating/selecting a Hot Folder, it already
contains files, a dialog displays a warning that processed
files will be deleted. All files placed into a Hot Folder are
DELETED after printing!

I can't get my TIFF/IT
files to process from a
Hot Folder.

TIFF/IT files (fp, ct, and lw) should be copied to the
Imation Server into a known storage location (not a hot
folder). Then a shortcut of the fp file should be copied (not
moved) to the local hot folder. Once files are processed or
RIP'ed from a Hot Folder, they are deleted. It is the
intention of Hot Folders to delete files after processing
because they are active RIP directories, not storage
locations.

My Macintosh®
Chooser doesn't know
which PPD file to use.

If the Chooser cannot determine which PPD file to use, or
if the Select PPD button is clicked, another dialog opens
and prompts you to select a PostScript Printer Description
File from the ppd folder listing. Click on the DocuColor12
(Imation) PPD and then click on the Select button. For
complete installation instructions, go to Macintosh Client
PPD Installation, located under Installing Imation
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Matchprint Professional Serve Software.

I recently installed
new software on my
computer. After that, I
started having trouble
with my system.

If you are experiencing difficulty with your system and you
recently installed new software on the computer, try
reinstalling Service Pack 6.

Windows® 95/98
only. When trying to
add a printer, the
Imation server
requests a password,
but does not allow the
user to log in as a
guest.

In order for a Windows®  95/98 user to add a printer, the
Imation server administrator must set the User Manager
for Domains Guest properties to a blank password and
check Password Never Expires. This allows the
Windows® 95/98 client workstation to add the Imation
spooler as a printer.

Spooler ID cannot be
deleted once it is
created.

If a Microsoft Windows®  client fails when trying to add or
print to a print spooler, the user should confirm the
spooler exists and is active on the server. When a print
server is deleted at the server, it is deleted from the
server and the network. However, any client's "Add Printer
Wizard" can still view the spooler name for up to 2 hours
after the spooler has been deleted. This is a known issue
with Microsoft Windows®. Users can confirm a spooler
exists by navigating to the server and viewing it over the
network.

Windows® 2000 only.
Error message, "Could
not complete the print
command because the
selected printer could
not be found."

At the client Windows machine, either log into the same
domain as the Imation Matchprint™ Professional
Server, or connect to the Imation Matchprint™ Server
with a valid user name and password that has a minimum
of read access. For security purposes, Imation does NOT
recommend enabling the Guest Account.

Printing a DCS2 file
with 2400 DPI
separation resolution,
8.5 x 11 with 6
separations can take
up to 3 hours to print.

The main DCS2 file contains a low resolution composite
representation of the original image. But, the Imation RIP
does not use it. To produce the highest quality proof, the
Imation RIP recombines the separations at full resolution.
This accurate color replication process takes time to
produce. Higher DPI resolution and a high number of color
separations will increase the processing time.

Calibration fails. If the calibration test fails, check to make sure the test
page is properly positioned on the scan glass. The scan
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area is 11"x17". If the pattern is off the edge, calibration
will fail.

After checking the placement of the calibration test page,
rescan the page.

Macintosh only. When
trying to do a File>
Print Window, the
following error occurs:
"postscript error:
rangecheck; offending
command: get"

On your Macintosh, try the following two work-arounds,
then try the Print Window option again:

• Under View > View Options, set the icon size to the
smallest setting.

• Under Print Window > Printer Specific Options >
Color Mode, select Grayscale.

Mailbox locations
aren't available.

Mailbox locations are available on the Imation Matchprint™
Professional Server only if mailbox is enabled on the Xerox
DocuColor 12 sorter. Contact your Xerox technician to
enable this setting.
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7.2 TIPS

How to Correct Duplexed, Second-Side Page Registration

Duplex printing (printing on both sides) is a wonderful feature in the Xerox
DocuColor 12. However, one printing concern that occurs on most duplex copiers
(including the DocuColor 12) is that the second side page image alignment is usually
out of register anywhere from 1/32" to 1/2". This is a concern if you are proofing
folded brochures or any document that requires accurate alignment on both sides.
This deficiency is caused by the mechanical components of the copier rather than the
data generated by the Imation Matchprint™ Professional Server. A technician can try
and repair an alignment problem, but the adjustment will shift after regular usage of
the copier.
Since there are no calibration settings in the Imation Matchprint™ Professional
Server, Xerox DocuColor 12, or the Adobe PostScript writer, the page alignment
must be done in the desktop publishing application (i.e., QuarkXPress, InDesign,
Pagemaker, etc.).
Use the following procedure to correct this alignment problem:

1. Create a registration guide on page one.
2. Copy the contents on page one and paste it in the same location as page one.
3. Print at least six copies of the two pages with Duplexing on.
4. Look at the two-sided printed media using a light table or a bright light

behind he media to inspect the out-of-alignment registration marks. Measure
the differences horizontally and vertically, then average the difference
between each copy.

5. Highlight all elements on the second page and move the contents the average
distances obtained in the previous step.

6. Print several copies to check the alignment.
There may be a 1/64" to 1/32" alignment difference between each copy, but the
registration will be significantly better than before.

Image Placement Issues

Several factors influence the orientation of an image on a printed page. These
include:
• whether the image is viewed in portrait or landscape mode,
• whether the user decides to rotate the image before printing,
• paper size, and
• whether the paper in the DocuColor 12 copier is fed Short Edge First (SEF) or

Long Edge First (LEF).
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8 Client Application Issues

This section contains known issues and work-arounds for various client applications.

DocuColor12 (Imation).ppd Does not Appear in the Setup Box.

1. Add a spooler to your client workstation. This action automatically loads the PPD
to your local drive.

2. Search for IMXDOC12.ppd on your local drive.

3. Copy the IMXDOC12.ppd to the following locations depending on your
application:

For QuarkXPress™, copy to
C:\WINNT\System32\Spool\DRIVERS\W32x86\2 folder
For PageMaker™, copy to C:\Program Files\Adobe
PM65\RSRC\USENGLISH\PPD4
For FreeHand™, copy to C:\Program Files\Macromedia\Freehand
9\English\PPDs

Note: These locations are default locations for PPDs. Contact your system
administrator, if the path names are different.

4. Relaunch your application. The .ppd will now appear in the Setup box when
printing.

Activating Duplex Setting in Client Applications

The duplex function must be set in the client application in order to function properly
on the DocuColor12. See the appropriate client application user guide for instructions
on activating the duplex feature.

Separations

In order to print trap, overprint, or spot color (PANTONE™) files, Separations must
be selected. Currently the applications that support separations are: QuarkXpress™,
Adobe PageMaker™, Adobe Illustrator™ 9, Adobe InDesign™ and Macromedia
FreeHand™.

Separations and Grayscale

If grayscale images are desired when printing from client applications, the
PostScript™ data must be sent as composite, not separated. If this is not done, the
image will print in color.

Windows® 2000 Client Print Error:  "Could not complete the print
command because the selected printer driver could not be found. Please select a
printer from the control panel and try again."

At the client Windows machine, either log into the same domain as the Imation
Matchprint™ Professional Server, or connect to the Imation Matchprint™ Server with
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a valid user name and password that has a minimum of read access. For security
purposes, Imation does NOT recommend enabling the Guest Account.

Printing DCS2 Files

• Printing a DCS2 file with 2400 DPI separation resolution, 8.5 x 11 with 6
separations can take up to 3 hours to print.

Explanation: The main DCS2 file contains a low resolution composite
representation of the original image. But, the Imation RIP does not use it. To
produce the highest quality proof, the Imation RIP recombines the separations at
full resolution. This accurate color replication process takes time to produce.
Higher DPI resolution and a high number of color separations will increase the
processing time.

• If you print one file of a multi-part DCS2 image, the selected separation will print
in grayscale.

Printing from Microsoft® Office 97 Applications

Microsoft® Word 97 and Excel: The Page Setup option in Microsoft® Word 97
and Excel applications takes precedence over spooler settings.

Microsoft® PowerPoint:  The Print Dialog settings in Microsoft® PowerPoint
takes precedence over spooler settings.

Note: Printer property settings in the DocuColor 12 must be correctly set to view the
available media settings within the client application. See Printer Setup for
additional information.
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9 Imation Color RIP

The Imation Raster Image Processor (RIP) converts vector graphic statements
(page description language such as PostScript®) into raster graphic images or
bitmap images that can be printed.

The following diagram illustrates the Imation RIP color workflow:

1. PostScript (.eps, spooling) files with RGB data is always converted to CMYK
internally before the RIP applies color correction. The conversion is done by
the PostScript interpreter.

2. The CIE-based colors available in PostScript level 3 include: XYZ, calibrated
RGB, L*a*b*, YIQ, YUV, calibrated gray, L*u*v*.

3. The user can select the default RGB color space in the event that "none" is
specified in the PostScript file.

4. When printing RGB raster files, you can optionally simulate a CMYK proofing
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target. See Advanced Color Tab Graph (below) for more information on the
"Office Color" setting. (The arrows indicate how or which profiles will be
used.) RGB files with "office color" turned off will simulate a CMYK target.

5. RIP'ed pages are saved before the printer linearization, so they can be re-
proofed on another printer and look the same.

Acronyms

CFM - Color Fidelity Management.

CIE - Commission International de l'Eclairage (International Commission of
Illumination). In the diagram used on this page the CIE is used in short for CIELAB.
CIELAB is an internationally accepted color space model used as a standard to define
color within the graphics arts industry. The CIELAB model designates L for the
lightness axis, A for the red-green axis and B for the yellow-blue axis.

CMYK - Cyan, magenta, yellow and black process colors or inks.

CRD - Color Rendering Dictionary.

CSA - Color Space Array.

RGB - Red, green and blue.
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10  Glossary

AppleTalk®: Communications protocol used by Macintosh® computers to
communicate over a local area network.

Calibration: The process of setting up a printer so the color matches the device
used to create its device profile.

CMYK: Cyan, Magenta, Yellow, and Black. These are the ink colors traditionally used
in full color printing.

Color Library: A collection of custom colors.

Contone: Continuous tone. An image in which each colorant of each picture element
may have values in a range larger than just 0 or 1 (generally 0 to 255). See also
Halftone.

Custom Color: A color other than Cyan, Magenta, Yellow, or Black, which is
intended by the page designer to be printed with a special custom ink. This color is
produced on the system by using CMYK to approximate the specified color.

Design Application: A software program used to create images for printing, such as
QuarkXPress™ or Adobe PageMaker™.

DFE: Digital Front End. An application server that acts as a spooler and RIP for a
color copier.

DTP: Desk Top Publishing. A process of electronically producing pages on personal
computers using commercially available software.

EPS: Encapsulated PostScript. A standard format for importing and exporting
PostScript files among applications.

Halftone: An image in which each colorant of each picture element may have only
the values 0 or 1.

Hotfolder: A folder or directory that is periodically scanned for files to be processed.

ICC: International Color Consortium. An industry consortium that has defined a
standard, cross-platform format for color interchange.

ICC Profile: A cross-platform file format that can be used to translate color data
created on one device into another device's native color space.

Job: The processing of an input file.

Job Log: A list of processed jobs.

Job Queue: A list of jobs waiting for processing.

Pantone Matching System™: A color library based on colors specified by Pantone,
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Inc. which is commonly used to specify custom colors.

PDF: Portable Document Format. An image format created by Adobe to allow easier
and more reliable exchange and viewing of electronic documents.

PostScript™: PostScript is a page description language developed by Adobe, which
has become the standard for desktop publishing. PostScript Level 2 is an extended
version of the language, which includes common modifications to the original
PostScript level 1 language (i.e. Color and Japanese Fonts) and some other new
features (i.e. Forms, Patterns, Compression, and Device Independent Color).

Print (noun): A paper hardcopy of an image that is not suitable for color critical
uses.

Proof (noun): A paper hardcopy of an image that may be used to judge color and
other characteristics before the image is reproduced on an imagesetter.

Proofer: A printer capable of producing proofs.

RGB: Red, Green, and Blue. These are the primary colors used in computer display
monitors and color projection systems.

RIP (noun) : Raster Image Processor. The process of converting a vector-based
page language, such as PostScript, into a bitmap for a printing or other display
device. (verb) Raster Image Processing (also RIP'ing): The act of using a Raster
Image Processor.

Separations: Individual cyan, magenta, yellow, black, and custom color plates that
make up an image.

Server: A computer on a network that acts as a source or repository of shared
information.

Spooler: A device that accepts files over a network for proofing or printing.

TCP/IP: Transmission Control Protocol/Internet Protocol. A standardized
network protocol commonly used by computers on the Ethernet.

TIFF: Tagged Image File Format. A common image file format used on both
Macintosh and IBM PC computers. This format supports black and white, RGB, and
CMYK images at any resolution.

TIFF/IT:An extension to the TIFF file format that includes the ability to combine
linework, contone, and high-resolution contone data in a single image.

Watermark: In Imation Matchprint™ Professional Server proofing, the watermark is
a line of text that appears in the upper-right corner of the proof, which reads:
"Simulation X'" for basic color mode and "Simulation X on Y" for advanced color
mode. Where X is the device link/profile used for color and Y is the media. The
watermark will only appear if an Imation profile/device link is used without a color
adjustment. In addition, the media must also be Imation media (Commercial, Pub,
Design, NOT bond) for the mark to appear.
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